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CHAPTER 1 Getting Started

Mesh Generator is a Tecplot add-on that provides the ability to create multi-zone two-dimen-
sional meshes. Both IJ-ordered (structured) and finite-element (unstructured) meshes may be 
generated using Mesh Generator. In addition, you can create hybrid meshes that combine both 
structured and unstructured mesh zones.

As an add-on, Mesh Generator is a shared library (dynamic link library in Windows) which is 
loaded at run time by the $!LOADADDON macro command in the tecplot.add file in your 
Tecplot Home Directory. Please refer to the Tecplot User’s Manual for further information 
about Tecplot add-ons.

1.1. Starting and Stopping Mesh Generator

The first thing you must know is how to begin a session in Mesh Generator, and how to end a 
session. The following describes how to start and stop Mesh Generator on various operating 
systems.

1.1.1. Starting and Stopping on UNIX Systems

Once Mesh Generator has been installed simply start Tecplot by your usual method. The words 
Mesh Generator should appear in the Tecplot Tools menu. On a UNIX operating system, to 
manually load Mesh Generator, type:

tecplot -loadaddon <fullpathname>/libmeshgen

In either case, from the Tecplot menu bar, you should then select the Tools menu, then select 
Mesh Generator. The Mesh Generator main dialog will appear; Mesh Generator is now run-
ning. You may move the Mesh Generator dialog to the side of the screen to avoid obstructing 
the Tecplot workspace.
1
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To end a session in Mesh Generator, simply exit Tecplot. You may close Mesh Generator’s 
main dialog by clicking Close on the lower left-hand side of the dialog. Selecting Mesh Gener-
ator from the Tools menu on the Tecplot menu bar will call it up again.

1.1.2. Starting and Stopping on Windows Systems

On Windows 95, 98 and NT 4.0, you should first start Tecplot. From the Tecplot menu bar, 
select Tools, then select Mesh Generator from the menu. The Mesh Generator main dialog will 
appear. Mesh Generator is now running.

To end a session in Mesh Generator, simply exit Tecplot. You may close Mesh Generator’s 
main dialog by clicking Close on the lower left-hand side of the dialog. Selecting Mesh Gener-
ator from the Tools menu on the Tecplot menu bar will call it up again.

1.2. Getting Acquainted with Mesh Generator

Mesh Generator’s main dialog is shown in Figure 1-1. The Mesh Generator main dialog is 
divided up into three menus and a check box:

• File: You may import IGES (Initial Graphics Exchange Specification) files containing 
NURB (Non-Uniform Rational B-splines) curve entities, read or write a Mesh Generator 
project file, or output generated meshes to an external file. A project file is a Tecplot layout 
file with Mesh Generator macro commands embedded in it. You can write a project file to 
save the current state of the mesh so that it may be used later.

• Boundary: All boundaries are lines which exist as one-dimensional I-ordered Tecplot 
zones with added geometry. A user can create and edit boundaries, set and distribute the 
nodes along these boundaries, get information about a specific boundary, and delete bound-
aries.

• Mesh: All two-dimensional zones are called meshes, whether IJ-ordered (structured) or 
finite-element (unstructured). Meshes may be generated using one of the four methods 
available: algebraic, elliptic, hyperbolic, or unstructured triangulation. Meshes may also be 
modified or deleted.

• Hide 2D Mesh: This check box enables or disables all two-dimensional zones. Disabling 
makes selecting a line in the current Tecplot frame easier.

The main dialog also provides the number of boundary lines and meshes.
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1.3. Creating Simple Meshes

This section will guide you through the creation of a simple mesh in Mesh Generator. First, it 
is helpful to have an introduction to the types of meshes which can be created in Mesh Genera-
tor, and the criteria for creating them.

1.3.1. Mesh Generation

Mesh generation information is stored based on Tecplot zones, therefore, you are strongly 
encouraged not to delete any zones by using the Delete Zone option under the Data menu in 
Tecplot. Instead, Mesh Generator zone deletion (Delete Selected Line or Delete Selected 
Mesh) should be used. We also recommend that while using Mesh Generator, all layout and 
project reading be done from Mesh Generator’s Open Project option under the File menu. Tec-
plot’s Open Layout option should only be used by first selecting the New Layout option from 
Tecplot’s File menu. Without this, Tecplot’s Open Layout option will create complications in 
Mesh Generator.

Figure 1-1. The Mesh Generator main dialog.
3
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Mesh Generator creates multi-zone, IJ-ordered (structured) and finite-element (unstructured) 
meshes. Two-dimensional meshes are defined by boundary lines. You define the lines and dis-
tribute the mesh points (nodes) along them. 

Meshes may be generated using one of the four methods available: algebraic, elliptic, hyper-
bolic, and unstructured Delaunay triangulation. Any combination of structured or unstructured 
meshes may be converted into either unstructured triangular meshes or unstructured rectangu-
lar meshes during the output operation.

When a mesh is generated using either algebraic or elliptic methods, this surface is defined by 
selecting lines that form the four boundaries (IMin, IMax, JMin and JMax) of the mesh.

Hyperbolic mesh generation only requires the mesh be defined by selected lines that form one 
boundary (JMin). The two side boundaries (IMin and IMax) may be restricted by selecting 
available constraints. However, the fourth boundary (JMax) remains free. This method is very 
fast and robust, but because of the free nature of the fourth boundary it may be better suited for 
meshes used for external flow calculations.

Unstructured meshes require each boundary to be a closed-loop which starts and ends at the 
same point. You can select lines in the current Tecplot frame to be added to a boundary in the 
boundary list. When a boundary is not a closed-loop, it is labeled as incomplete in the bound-
ary list. Once the user selects all the lines which make up a closed-loop, it will be shown as 
either an external or internal boundary on the list. More than one boundary may be specified 
for an unstructured mesh.

1.3.2. Creating the Boundaries

Algebraic and elliptic meshes are formed from bounding edges identified as IMin, IMax, JMin 
and JMax, corresponding to the minimum and maximum values of the indices for the two fam-
ilies of lines (I and J) that define the structure (order) of the mesh. The lines defining these 
bounding edges are entered into the Algebraic/Elliptic mesh generator by referencing their 
Tecplot zone numbers. A minimum of one boundary line is required to define each bounding 
edge. However, more than one boundary line may be used. To maintain consistency of the 
mesh points, opposing bounding edges must have equal numbers of mesh points. Therefore, 
the IMax and IMin edges must both have the same number of mesh points. Similarly, the JMin 
and JMax edges must both have an equal number of mesh points.
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Additionally, these mesh boundaries must be closed and the following points must be coinci-
dent:

• IMin=1 and JMin=1.

• IMin=max and JMax=1.

• IMax=max and JMax=max.

• IMax=1 and JMin=max.

Under these requirements IMin and IMax must increase in the same direction, and JMin and 
JMax must increase in the same direction.

Note: When mesh boundaries are created from multiple boundary lines, adjacent lines must 
have coincident mesh points (nodes). One of these nodes will be automatically removed after 
the boundary is assembled.

1.3.2.1. Creating the JMin Boundary. To create the JMin boundary, perform the follow-
ing steps:

1. Click on the Boundary menu, then select the Create Circular Arc option. This will call up 
the Circular Arc dialog, shown in Figure 1-2. The first option in the Line Definition area of 
the dialog is Specify. Here, there are options: Center, Starting Point, Arc Angle; and Start-
ing, Ending Point, Radius. Click on the latter.

2. In the Arc area of the dialog, enter 0 for X and 0 for Y in the Start text fields, and 1 for X 
and 1 for Y in the End text fields. Accept the remaining default values. Use the Line Label 
text field to name this boundary line “b1” and click on Create. The arc will be created in the 
current Tecplot frame. Close the Circular Arc dialog.

3. Now we will add a polyline to the JMin boundary. Call up the Polyline dialog by selecting 
the Create Polyline option from the Boundary menu. The Polyline dialog is shown in Fig-
ure 1-3. 

4. On the left of this dialog is a list titled Control Points. When you are first defining a new 
polyline boundary, this list will be empty. To the right of the Control Points list are two text 
fields labeled X and Y. There are three ways to enter the control point values for your 
polyline: by using Tecplot’s Selector tool in conjunction with the Select Endpt. button on 
the Polyline dialog, by entering the values manually into the text fields, and by converting a 
Tecplot geometry. For this polyline we will use the first and second.

5. With the Tecplot Selector tool click on b1 near one of its nodes closet to its end point of 1, 
1. On the Polyline dialog, click Select Endpt. This inserts b1’s end points into the X and Y 
text fields. Click on Insert Before to enter the point into the list. Now enter 5 for X and 1 for 
Y in the text fields. Click Insert After.
5
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6. Now click Node Distribution on the Polyline dialog. This will call up the Node Distribution 
dialog, shown in Figure 1-4. In the Node Distribution area, set the Distribution drop-down 
to Even Spacing. Next, set Number Of Nodes to 30. Accept all other default values and 
click OK.

7. On the Polyline dialog, use the Line Label text field to name this boundary line “b2.” Click 
Create. The new boundary line will be drawn in your current Tecplot frame.

Boundary lines b1 and b2 form a blunt body, as shown in Figure 1-5.

1.3.2.2. Creating the IMin Boundary. To create the IMin boundary, IMin=1 must be coin-
cident with JMin=1. Perform the following steps:

Figure 1-2. The Circular Arc dialog. 
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1. With your Tecplot Selector tool, select a node on b1 near its starting point of 0, 0. Click 
Select Endpt. on the Polyline dialog to enter the X and Y values in the Control Points list. 
In this case, X and Y will each be shown as 0. Click Insert Before. Now manually enter the 
values -5, 0, for X and Y, and click Insert After.

2. Now click Node Distribution. On the Node Distribution dialog set Distribution to Even 
Spacing, Number Of Nodes to 30, and accept all other default values. Click OK.

3. On the Polyline dialog, use the Line Label text field to name this boundary line “b3.” Click 
Create. The new boundary line will be drawn in your current Tecplot frame.

4. From the Tecplot menu bar, select the View menu, then select the Data Fit option to display 
all of the newly created boundary line.

1.3.2.3. Creating the IMax Boundary. To create the IMax boundary, according to the 
boundary orientation rules, the highest index of JMin must be coincident with IMax=1. Thus, 
this boundary should be a polyline which begins at 5, 1, and which will end at 5, 6. Perform the 
following steps:

Figure 1-3. The Polyline dialog. 
7
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1. With the Selector, click on a node near the end point of b2 near 5, 1. Click Select Endpt. It 
will automatically enter the X and Y values of the nearest end point. Click Insert Before. 
Now manually enter 5 and 6, as the X and Y coordinates for the IMax boundary. Click 
Insert After. 

2. Click Node Distribution and set Distribution to Even Spacing, Number Of Nodes to 30, and 
accept all other default values. Click OK. 

3. Use the Line Label text field on the Polyline dialog to name this boundary line “b4.” Click 
Create. Close the Polyline dialog.

4. From the Tecplot menu bar, select the View menu, then select the Data Fit option to display 
all of the newly created boundary line.

1.3.2.4. Creating the JMax Boundary. To create the JMax boundary, the JMax starting 
node, JMax=1, must be coincident with IMin=max. Also, the JMax=max and IMax=max must 
be coincident. Finally, JMax must have 59 nodes, the same number as b1 and b2 (though both 

Figure 1-4. The Node Distribution dialog. 



1.3. Creating Simple Meshes
boundaries have 30 nodes, they lose one at the overlapping node), the JMin boundary. Perform 
the following steps:

1. Call up the Create Circular Arc dialog under the Boundary menu. First, set the Specify 
option button to Starting, Ending Point, Radius. Use of the Selector tool method to insert 
IMin’s start point of -5, 0, as JMax’s start point and IMax’s end point of 5, 6, as JMax’s end 
point. Set the Radius text field to 10.

2. Click Node Distribution. On the Node Distribution dialog, set Number Of Nodes to 59. All 
other default values are correct for our arc. Click OK.

3. Use the Line Label text field on the Circular Arc dialog to name the JMax boundary “b5.” 
Click Create. Close the dialog.

The resulting boundaries are shown in Figure 1-5.

1.3.3. Creating the Mesh

With the boundaries defined, you are now ready to create the mesh. To do this, perform the fol-
lowing steps:

Figure 1-5. The blunt body with boundaries in place. 
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1. Use the Mesh menu to select the create Algebraic/Elliptic Structured. The Mesh menu is 
shown in Figure 1-6. The Algebraic/Elliptic Structured dialog offers three methods for 

inserting boundaries into the four mesh boundary zone fields. The information can be 
entered manually, by clicking Add From List and selecting the appropriate boundary line 
from the menu, or by using the Tecplot Selector tool to select a boundary line and then 
clicking Add Selected. Ensure that no zones are selected in the current Tecplot frame by 
clicking on a blank region of the frame. 

2. Enter the IMin boundary by selecting the Add From List on the Algebraic/Elliptic Struc-
tured dialog, which is shown in Figure 1-7. Select the boundary line b3, the boundary corre-
sponding to zone 3, from the list. Click OK.

3. For the IMax boundary, enter boundary line b4 by using the Selector to select it in the cur-
rent frame. Note Add From List changes to read Add Selected. Click Add Selected. Use 
any method to define JMin as b1 and b2, and finally JMax as b5.

4. Accept the default Mesh Control Method of Algebraic-Arclength, name the mesh as 
“arclength” in the Mesh Label text field, then click Create. The Working dialog will appear 
while the new mesh is generated. When mesh generation is complete, close the dialog.

Figure 1-6. The Mesh menu. 
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The resulting mesh is shown in Figure 1-8. 

Leave this example in your current Tecplot frame, as we will refer to it again in following sec-
tions.

1.4. Modifying and Converting Boundaries and Meshes

Mesh Generator allows you to modify your existing boundaries and meshes in a number of 
ways. As an introduction to Mesh Generator’s capabilities, we will now change the node distri-
bution and method of mesh generation on the blunt body configuration we have developed in 
the previous examples.

Figure 1-7. The Algebraic/Elliptic Structured dialog. 
11
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1.4.1. Modifying Boundaries

First, we will change the node distribution on the JMin boundary lines, b1 and b2, then the 
JMax boundary line, b5. To make line selection easier, you may find it useful to click on the 
Hide 2D Mesh check box on the Mesh Generator main dialog, and then click Redraw on the 
Tecplot sidebar. The existing mesh will no longer be shown. Now perform the following steps:

1. Using the Tecplot Selector tool, click on a node on b1.

2. On the Boundary menu, choose Edit Selected Line. This will call up the Circular Arc dia-
log, displaying the information for b1.

3. Click Node Distribution. On the Node Distribution dialog, change Distribution to Exponen-
tial and Number Of Nodes to 15. Accept the other values and click OK.

4. On the Circular Arc dialog, click on Replace, then click Close.

5. Click on b2, the second line making up the JMin boundary. Then select Edit Selected Line 
from the Boundary menu.

Figure 1-8. The Algebraic-Arclength mesh.
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6. Click Node Distribution. On the Node Distribution dialog set Distribution to Exponential, 
Number Of Nodes to 15, and accept all other default settings. Click OK.

7. On the Polyline dialog click Replace, then close the dialog.

8. Click on b5, the JMax boundary line. Then choose Edit Selected Line from the Boundary 
menu.

9. Click Node Distribution. On the Node Distribution dialog set Distribution to Polynomial, 
Number Of Nodes to 29, click on the One-Sided (Initial) option, and accept all other default 
settings. Click OK.

10. On the Circular Arc dialog click Replace, then close the dialog.

The result of these changes is shown in Figure 1-9.

1.4.2. Modifying Meshes

Next we will change the existing mesh. Deactivate the Hide 2D Mesh option, then click 
Redraw. Now perform the following steps:

Figure 1-9. The existing boundaries with the node distribution changed.
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1. Click on the existing mesh labeled arclength, then go to the Mesh menu and click Edit 
Selected Mesh.

2. Under Mesh Control on the Algebraic/Elliptic Structured dialog, set Method to Elliptic-
Laplace, and accept its default values. Use the Mesh Label text field to rename the new 
mesh “laplace” and click on Replace. The Working dialog will appear while the new mesh 
is generated. Close the dialog when mesh generation has completed.

The resulting Laplace mesh is shown in Figure 1-10.

1.4.3. Converting Meshes

Mesh Generator can convert structured meshes to unstructured meshes quickly through its 
mesh conversion capabilities. To do this, select the File menu, then select the Write Mesh File. 
This will call up the Mesh Output dialog. Here you have the option of selecting either Single 

Figure 1-10. The modified Laplace mesh.
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1.5. Saving Your Work
Triangular or Single Quadrilateral Zone conversion, which may be performed on selected 
meshes in your current Tecplot data set.

The Mesh Output dialog is shown in Figure 1-11.

Note: Mesh conversion can be performed for PLOT3D files, however, PLOT3D files do not 
contain any boundary information. Also, PLOT3D files may contain either structured or 
unstructured zones, not both.

1.5. Saving Your Work

There are four options on Mesh Generator’s File menu which are associated with input/output. 
These are:

• Import NURB file.

Figure 1-11. The Mesh Output dialog.
15
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• Open project.

• Save Project.

• Write Mesh file.

1.5.1. Import NURB File 

This allows you to read a curve from a NASA-IGES NURBS-ONLY file. Clicking Read 
NURB file calls up a standard file input dialog box. After the file is selected, a one-dimen-
sional Tecplot zone is created by distributing a default number of evenly spaced mesh points 
along the NURB curve. The distribution of the mesh points along the NURB curve may be 
changed by editing the line using the Edit Selected Line option.

1.5.2. Open Project

Project files store the current state of a Mesh Generator session. If a session is interrupted, you 
may write a Project file, exit Tecplot, and continue at a later time by reading in the Project file.

1.5.3. Save Project

Project files store the current state of a mesh generation session, and also include a history of 
your previous iterations. When writing a project file a standard output dialog appears, with the 
default extension shown as .lay (layout file). If the Tecplot zones were saved in a .plt 
(plot file) you would be unable to edit the mesh later.

1.5.4. Mesh Output

Mesh Generators’s goal is to create a two-dimensional structured and/or unstructured (finite-
element) mesh for use by analysis codes. If it is a multiple zone mesh, the analysis code may 
also require information describing connectivity the between the zones. This information is 
saved in a mesh file. Clicking Mesh Output calls up the Mesh Output dialog. In this dialog 
there is an option for choosing the mesh file format, a multi-selection list for picking the zones 
to include the mesh file, and the standard OK, Cancel, and Help buttons. Mesh file formats 
supported are Tecplot and PLOT3D, both ASCII and binary. Only two-dimensional zones are 
included in the multi-selection list. Clicking OK in the Mesh Output dialog calls up the stan-
dard file output dialog.

Note: Project files that contain Mesh Generator commands will not work as expected when 
reading into the Tecplot applications which do not have Mesh Generator installed.
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1.6. Macro Files

Another feature which may be useful to you is the ability to record macros in Mesh Generator. 
This creates a record of steps you have taken in your current Tecplot session. To record a 
macro, perform the following steps:

1. Click File on the Tecplot menu bar (not in Mesh Generator), and select Macro, then Record.

2. Name your file and save it as a .mcr (macro) file. This will call up the Macro Recorder 
dialog. See Section 26.1.1, “Recording Macros” in your Tecplot 7.5 User’s Manual for 
more information about this dialog.

3. You can stop recording at any time by clicking Stop Recording on the Macro Recorder dia-
log. 

4. You can replay your macro recording by selecting the File menu on the Tecplot menu bar, 
selecting Macro, and then Play.

Note: Once you begin recording a macro, you must not resize your Tecplot workspace, or you 
will cause an error in your recording and be unable to play it back later. Macro files that 
contain Mesh Generator commands will not work as expected in Tecplot applications which do 
not have Mesh Generator installed.

1.7. Getting Help in Mesh Generator

Mesh Generator features an on-line help system, which is integrated into the interface. Help is 
always available by clicking the Help button in any of the Mesh Generator dialogs.

Help is also available from 6:30 a.m. to 5:00 p.m. Pacific Standard Time from Technical 
Support at (425) 653-9393. You can also send e-mail to support@amtec.com with your 
support questions.
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CHAPTER 2 Creating Boundaries

This chapter discusses creating and editing the boundaries for your mesh. Boundaries are the 
lines used to define the sides, or edges, of your mesh. It is not necessary for each boundary line 
to completely define a mesh, since they can be combined at the time the mesh is created. This 
gives you the flexibility to create the mesh boundaries in sections. Each created boundary line 
exists as a Tecplot one-dimensional I-ordered zone, and can be uniquely labeled for easy iden-
tification.

Mesh Generator features several options for creating boundary lines. By selecting the Bound-
ary menu, you will display these options, as shown in Figure 2-1. You can create boundary 
lines from simple geometries such as polylines, circular arcs, and conic arcs. They can also be 
created from existing boundary lines, or by extracting from other I- or IJ-ordered Tecplot 
zones. You can use Mesh Generator to convert Tecplot geometries to boundary lines. Mesh 
Generator will also let you import an IGES-NURB file, which will allow you to create bound-
aries based on NURB definitions.

2.1. Polylines

A simple method for creating a boundary line is to specify a polyline. A polyline is a set of 
connected line segments. A line segment is defined by entering its starting and ending point 
coordinates. Polylines are created by specifying the coordinates of more than two points. The 
points you specify are called control points.

Control points are used to define the shape of a boundary. Several options are available to let 
you specify control points: they may be entered manually, selected from the end point of an 
existing boundary line, or converted from a Tecplot polyline geometry. You may not define two 
identical control points, one after another.

To call up the Polyline dialog in Mesh Generator, select the Boundary menu, then choose the 
Create Polyline. The Polyline dialog is shown in Figure 2-2.
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2.1.1. Line Definition

The Line Definition area of the Polyline dialog is where control points are entered for the 
polyline you wish to create. On the left of this dialog is a list labeled Control Points. When you 
are first defining a new polyline boundary, this list will be empty. The list will expand as you 
add control points.

2.1.1.1. Entering Control Points. To the right of the Control Points list are two text fields 
labeled X and Y. These are the X- and Y-coordinate text fields where you can enter a new 
control point or edit an existing control point.

Next to the X and Y text fields is the Select Endpt. button, which is active only when a bound-
ary line is selected in the current Tecplot frame. This button allows you to automatically enter 
the coordinates of the end point closest to a node selected with the Tecplot Selector tool. This 
allows an exact specification of a given end point without having to manually enter the values. 
It avoids mismatch errors which can create problems when attempting to combine the multiple 
boundaries of a mesh.

Figure 2-1. The Boundary menu.



2.1. Polylines
After coordinates have been entered into the X and Y text fields, you can use one of the four 
action buttons directly below the fields. These are:

• Replace: Replaces a selected point in the Control Points list with the values shown in the X 
and Y text fields. It is used to edit an existing control point, and is inactive until at least one 
control point is defined.

• Insert Before: Adds a control point to the list by inserting the values shown in the X and Y 
text fields, either before a point you have selected in the list, or as the first point if the list is 
empty.

• Insert After: Adds a control point by inserting the values shown in the X and Y text fields 
after a point you have selected in the list, or as the first point if the list is empty.

• Delete: Removes a selected control point from the list. It is inactive until at least one con-
trol point is defined.

2.1.1.2. Converting Polyline Geometries to Boundaries. To the right of the four 
action buttons is the Convert Polyline Geometry Insert After button. This is active only when a 
Tecplot polyline geometry is selected in the current frame with the Selector tool. Clicking on 

Figure 2-2. The Polyline dialog. 
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this button will convert a selected polyline geometry into a set of control points, which are then 
inserted after a selected point in the Control Point list. This will allow you to draw a polyline 
with the Tecplot drawing tool, then convert it directly into a boundary, without having to man-
ually enter the control points.

Note: After using the Convert Polyline Geometry Insert After button, the selected geometry is 
deleted from the current Tecplot frame.

2.1.1.3. Using a Subset of the Specified Control Points. An option to use a subset of 
the control points you have specified is also available. You can do this by specifying the start-
ing and ending indices of the desired control points as they appear in the Control Points list.

The starting and ending indices are entered into the two text fields labeled Start and End in the 
Line Definition area of the Polyline dialog. These are shown on Figure 2-2. The default value 
for the starting index is 1, and the default value for the ending index is Mx. The ending index 
will accept any integer between 1 and Mx as well as Mx-a where a is some integer provided 
that Mx-a is greater than or equal to 2. The starting point of the newly created polyline will be 
the control point defined by the Start index, and the ending point will be the control point 
defined by the End index. Any interpolations performed on the resulting polyline will be based 
on all of the control points you have specified in the Control Points list, regardless of the start-
ing and ending index values.

2.1.2. Node Distribution

The number of nodes, the distribution option, and the interpolation on a boundary is set by 
clicking Node Distribution. The button is active only after at least two control points have been 
specified. When you click Node Distribution, the Node Distribution dialog will be called up. 
This is discussed in Section 2.7, “Distributing Nodes Along Boundaries.” The default Distribu-
tion is As Is and default Number Of Nodes is the number of control points available.

2.1.3. Labeling a Polyline

A name can be assigned to each polyline you create. This simplifies boundary definition when 
choosing from a list to create your mesh. The Line Label text field is located at the bottom of 
the Polyline dialog, you may enter any characters you wish.



2.2. Circular Arcs
2.1.4. Creating a Polyline

The new polyline will be created and displayed in the current Tecplot frame after you click 
Create. It will be a Tecplot I-ordered zone. After clicking Create, the Polyline dialog will be 
reset with its default values. 

2.2. Circular Arcs

Mesh Generator provides three ways to create boundaries using circular arcs. To call up the 
Circular Arc dialog, select Boundary from Mesh Generator’s menu, then select Create Circular 
Arc. The resulting Circular Arc dialog is shown in Figure 2-3.

Figure 2-3. The Circular Arc dialog.
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2.2.1. Line Definition

The Line Definition area of the Circular Arc dialog allows you to create circular arcs using one 
of three different methods.

2.2.1.1. Specifying Circular Arcs. Two options are available by clicking on the option 
buttons under Specify in the Line Definition area of the Circular Arc dialog. These are:

• Center, Starting Point, Arc Angle: Specifies the center (origin), the starting point on the 
circumference of a circle, and the arc angle of a circle.

• Starting, Ending Point, Radius: Specifies both the starting and ending points on the cir-
cumference of a circle with a specified radius.

The default direction of circular arcs in Mesh Generator is clockwise. You may reverse the 
direction by clicking on the Counter Clockwise check box.

Note: In instances where two solutions are possible, the smaller arc will always be selected.

Depending upon which option is selected under Specify, the text fields in the Arc area of the 
Circular Arc dialog will be active or inactive. The X- and Y-coordinates for the appropriate 
points may be manually entered into the text fields labeled X and Y. You must enter a value in 
units of degrees in the Arc Angle text field. The value entered in the Radius text field must 
have units consistent with the X- and Y-coordinates.

Next to the X and Y text fields for Start and End are two Select Endpt. buttons, which are 
active only when another boundary line is selected in the current Tecplot frame. The Select 
Endpt. buttons allow you to automatically enter the coordinates of the end point closest to a 
node selected with the Tecplot Selector tool. This allows an exact specification of a given end 
point without having to manually enter the values. It avoids mismatch errors which can create 
problems when attempting to combine the multiple boundaries of a mesh.

2.2.1.2. Converting Circle Geometries into Boundaries. To the right of the Counter 
Clockwise check box is the Convert Circle Geometry button. This is active only when a 
Tecplot circle geometry is selected in the current frame. By clicking on this button, the selected 
circle geometry is converted into a circular arc of 360 degrees. This allows you to draw a circle 
with the Tecplot circle drawing tool and directly convert it into a boundary in Mesh Generator.

Note: After clicking Convert Circle Geometry, the selected circle geometry is deleted from the 
current Tecplot frame.



2.3. Conic Arcs
2.2.2. Node Distribution

The number of nodes, the distribution option, and the interpolation on a circular arc is set by 
clicking Node Distribution. When you click Node Distribution, the Node Distribution dialog 
will be called up. This is discussed in Section 2.7, “Distributing Nodes Along Boundaries.” 
The default Distribution is Even Spacing and default Number Of Nodes is 30.

2.2.3. Labeling a Circular Arc Boundary

A name can be assigned to each boundary you create. This simplifies boundary selection when 
choosing from a list to create your mesh. The Line Label text field is located at the bottom of 
the Circular Arc dialog, you may enter any characters you wish.

2.2.4. Creating a Circular Arc Boundary

The new circular arc boundary will be created and displayed in the current Tecplot frame after 
you click Create. It will be a Tecplot I-ordered zone. After clicking Create, the Circular Arc 
dialog will be reset with its default values. 

2.3. Conic Arcs

The conic arc option allows you to create analytically defined boundaries such as ellipses, 
parabolas, and hyperbolas. To call up the Conic Arc dialog, click Boundary on the Mesh Gen-
erator menu, then select Create Conic Arc. The Conic Arc dialog is shown in Figure 2-4.

2.3.1. Line Definition

The Line Definition area of the Conic Arc dialog allows you to input values that control the 
shape and extent of your conic arc. A conic arc is defined by entering the X- and Y-coordinates 
of the Start and End points of the arc, and entering the Vertex, which joins the Start and End 
point to form a triangle enclosing the conic arc. The X- and Y-coordinates for these points are 
entered in the text fields labeled X and Y.

Next to the X and Y text fields for Start and End are two Select Endpt. buttons, which are 
active only when another boundary is selected in the current Tecplot frame. The Select Endpt. 
buttons allow you to automatically enter the coordinates of the end point closest to a node 
selected with the Tecplot Selector tool. This allows an exact specification of a given end point 
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without having to manually enter the values. It avoids mismatch errors which can create prob-
lems when attempting to combine the multiple boundaries of a mesh.

The Length Ratio defines where the conic arc curve intersects the bisection line creating the 
middle point (mid point between the Start and End points) and the Vertex. This number is the 
ratio of length from the middle point to the intersection point, and the length from the middle 
point to the vertex. The value entered in the text field for the Length Ratio determines the ana-
lytic shape of the conic arc. 

Acceptable values for the Length Ratio are: 0<Length Ratio<1.0.

Also:

• Ellipse: 0<Length Ratio<0.5.

• Parabola: Length Ratio=0.5.

• Hyperbola: 0.5<Length Ratio<1.0.

Figure 2-4. The Conic Arc dialog.



2.3. Conic Arcs
2.3.2. Node Distribution

The number of nodes, the distribution option, and the interpolation on a conic arc is set by 
clicking on Node Distribution. When you click Node Distribution, the Node Distribution 
dialog will be called up. This is discussed in Section 2.7, “Distributing Nodes Along Bound-
aries.” The default Distribution is Even Spacing and default Number Of Nodes is 30.

2.3.3. Labeling a Conic Arc Boundary

A name can be assigned to each boundary you create. This simplifies boundary selection when 
choosing from a list to create your mesh. The Line Label text field is located at the bottom of 
the Conic Arc dialog, you may enter any characters you wish.

2.3.4. Creating a Conic Arc Boundary

The conic arc will be created and displayed in the current Tecplot frame after you click Create 
button. It will be a Tecplot I-ordered zone. After clicking Create, the Conic Arc dialog will be 
reset with its default values. 

To illustrate the creation of boundaries using variations of the options discussed above, we will 
continue the example from section 1.3.2, “Creating the Boundaries.” Perform the following 
steps:

1. Click on the Boundary menu, then select Create Polyline. This will call up the Polyline dia-
log.

2. On the dialog, enter the coordinates 5 for X and 0 for Y, then click Insert Before. 

3. Use the Tecplot Selector tool to select boundary b2 near the end point. Only the Polyline 
dialog, click Select Endpt., then click Insert After. At this point there should be two points 
in the Control Point list: (5, 0) and (5, 1).

4. Click Node Distribution, which calls up the Node Distribution dialog. On the dialog, set 
Distribution to Even Spacing, and Number Of Nodes to 20. Accept all other default values 
and click OK.

5. Use the Line Label text field to name this polyline “b6,” then click Create.

6. Create an additional polyline with a start point coincident with the starting node of b6 at 5, 
0, and its end point at 10, 0. Click Node Distribution and set Distribution to Even Spacing 
and Number Of Nodes to 30. Accept all other default values and click OK.

7. Use the Line Label text field to name this polyline “b7,” then click Create.
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8. Create a new polyline “b8,” with its start point coincident with the end point of b7 at 10, 0 
and 10, 6, with 49 evenly spaced nodes.

9. Create one more polyline with its start point coincident with the end point of b4 at 5, 6, and 
the end point of b8 at 10, 6. Set Distribution to Even Spacing and Number Of Nodes to 30. 
Use the Line Label text field to name this polyline “b9.”

The new boundaries are shown in Figure 2-5.

Since we want a different outer boundary on the front end of our blunt body, we will need to 
modify two of the existing boundary lines and replace them. One way to do this is to simply 
delete the zone.

1. If the mesh named laplace is present, use the Tecplot Selector tool to select it, then select 
the Delete Selected Mesh option from the Mesh menu. Then, using the Tecplot Selector 
tool, select polyline b3 in the current Tecplot frame, then click on the Boundary menu, 
selecting the Delete Selected Line option.

2. Now repeat step 9 to delete boundary b5.

Figure 2-5. The modified blunt body.
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2.4. Importing Boundary Files
3. To create a replacement for b3, click on the Boundary menu and select Create Polyline. On 
the Polyline dialog, enter the coordinates 0 for X and 0 for Y and click Insert Before. Now 
enter the coordinates -2 for X and 0 for Y and click Insert After.

4. Now click Node Distribution. On the Node Distribution dialog, set Distribution to Even 
Spacing and Number Of Nodes to 30. Accept all other default settings and click OK.

5. On the Polyline dialog, use the Line Label text field to name this boundary “b3” and click 
Create.

6. To replace boundary b5 we want to create a conic arc shaped like an ellipse.

7. Use the Tecplot Selector tool select a node on b3 near its end point. Now click on the 
Boundary menu and select Create Conic Arc. This will call up the Conic Arc dialog. On the 
dialog, click Select Endpt., across from the Start text fields. Use the Tecplot Selector tool to 
click on a node near the end of b4. On the Conic Arc dialog, click Select Endpt. across from 
the End text fields. Now enter the coordinates -2, 6 for Vertex, then set the Length Ratio to 
0.4.

8. Click Node Distribution. On the Node Distribution dialog, set Distribution to Even Spacing 
and Number Of Nodes to 30. Click OK.

9. On the Conic Arc dialog, use the Line Label text field to name this boundary “b5,” then 
click Create.

10. Now change the Distribution for b1 and b2 to Even Spacing, and set Number Of Nodes 
equal to 30.

The resulting boundaries are shown in Figure 2-6.

2.4. Importing Boundary Files

For situations where the boundary definition exists as a file containing X- and Y-coordinates, 
or an IGES-NURB definition created by CAD software, you can import data to create bound-
aries within Mesh Generator.

2.4.1. Loading Tecplot Data Files

If the boundary is defined by pairs of X- and Y-coordinates in a file that can be read by Tecplot, 
you can load the file using Load Data File(s). This is found under the File menu on Tecplot’s 
menu bar. The data can be lines (I-ordered zones) or meshes (IJ-ordered zones). These exist as 
Tecplot zones and may be used to create boundaries for new meshes, which will be discussed 
in later sections. The imported files can also be used directly as boundaries, provided their 
node distributions are sufficient.
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2.4.2. Importing NURB Files

This utility allows you to read a curve from a NASA-IGES NURB-ONLY file.

To call up the Read IGES File dialog, click File on the Mesh Generator menu, then select 
Import NURB File from the list. The Read IGES File dialog will appear, as shown in Figure 2-
7. This is a standard file input dialog. After you select your file, a one-dimensional I-ordered 
Tecplot zone will be created by distributing a default number of evenly-spaced nodes along 
each NURB curve in the file. 

The distribution of mesh points along the NURB curves may be changed by editing the line 
with the Edit Selected Line option on the Boundary menu.

2.5. Creating New Boundaries from Existing Boundaries

Mesh Generator allows you to create new boundaries from previously created boundaries, or 
other I-ordered zones that may have been imported. For example, this may be necessary when 
a new, denser mesh is desired for an existing boundary configuration.

Figure 2-6. Modified blunt body with elliptic outer boundary.
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2.5. Creating New Boundaries from Existing Boundaries
2.5.1. Creating Boundary Lines from Existing Lines

This option is activated by first selecting a line in your current Tecplot frame. Next, click on the 
Boundary menu, then select Create From Selected Line.

The dialog which appears will depend on what type of boundary you selected. Options include:

• Polyline: The Polyline dialog appears and the nodes from the polyline are inserted into the 
Control Points list. You can then perform whatever actions are needed to define your new 
boundary.

• Circular Arc: The Circular Arc dialog appears and the text fields displaying the same 
information used to create the line you selected. You can now perform whatever actions are 
needed to define your new boundary.

• Conic Arc: The Conic Arc dialog appears and the text fields displaying the same informa-
tion used to create the line you selected. You can now perform whatever actions are needed 
to define your new boundary.

Figure 2-7. The Read IGES dialog.
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• Extracted Line: The Extract Selected Line dialog appears and the text fields displaying the 
same information used to create the line you selected. You can now perform whatever 
actions are needed to define your new boundary.

• Extracted Mesh: The Extract Selected Mesh dialog appears and the text fields displaying 
the same information used to create the line you selected. You can now perform whatever 
actions are needed to define your new boundary.

• Imported NURB line: The Node Distribution dialog appears. You can now change the 
node distribution for your new boundary.

• All other lines: The Polyline dialog appears and the points from the selected line are dis-
played in the Control Points list. You can now perform whatever actions are needed to 
define your new boundary.

2.5.2. Labeling the Boundary

A name can be assigned to each boundary you create. This simplifies boundary selection when 
choosing from a list to create your mesh. You may enter any characters you wish in the Line 
Label text field.

2.5.3. Creating the Boundary

The new boundary will be created and displayed in the current Tecplot frame after you click 
Create. It will be a Tecplot I-ordered zone.

To demonstrate this feature we will continue building on the blunt body example we last 
changed in Section 2.3, “Conic Arcs.” Now we will create a new boundary line from b5, which 
will have a parabolic shape and more nodes. To do this, perform the following steps:

1. Using the Tecplot Selector tool, select b5 in the current Tecplot frame. Now click on the 
Boundary menu and select Create From Selected Line. This will call up the Conic Arc dia-
log.

2. We want to change the shape to a parabola, so set Length Ratio to 0.5.

3. Click Node Distribution. On the Node Distribution dialog set Number Of Nodes to 59. 
Accept all other default values and click OK.

4. On the Conic Arc dialog use the Line Label text field to name this boundary “b10,” then 
click Create. Close the dialog.

5. Use the Tecplot Selector tool to select b5 in the current Tecplot frame, then click on the 
Boundary menu. Select the Delete Selected Line option on the menu. This will remove 
boundary b5.



2.6. Extracting New Boundaries
The new boundary is shown in Figure 2-8.

2.6. Extracting New Boundaries

Mesh Generator allows you to extract a new boundary from an existing line (I-ordered zone) or 
mesh (IJ-ordered zone). These may be previously created boundaries or meshes, or they may 
be zones which were loaded into Tecplot. How you extract a new boundary will depend upon 
whether you have selected a line or a mesh.

2.6.1. Extracting from a Selected Line

This option is activated by selecting a line in your current Tecplot frame. This will then be used 
for extracting the new boundary. Under the Boundary menu, select Extract From Selected 
Line. This will call up the Extract Selected Line dialog, as shown in Figure 2-9.

Figure 2-8. Modified blunt body with parabolic outer boundary.
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In the Line Definition area of the dialog you must specify the starting and ending indices of the 
selected line which are to be extracted to create your new boundary. These indices are entered 
into the Start and End text fields. No node distribution changes are allowed when extracting. 
Therefore, the only editing permitted on an extracted line is modification of the starting and 
ending indices. Valid values for both starting and ending indices are from 1 to maximum 
number of nodes on the selected line.

Note: You are allowed to reverse line direction. You may do this by entering a Start index value 
greater than that of the End index value. This in effect reverses the line direction for your 
newly extracted boundary line. The extracted nodes will be the same, but the index order will 
proceed in the opposite direction along the line.

Figure 2-9. The Extract Selected Line dialog.



2.6. Extracting New Boundaries
2.6.2. Labeling the Boundary

A name can be assigned to each boundary you create. This simplifies boundary selection when 
choosing from a list to create your mesh. You may enter any characters you wish in the Line 
Label text field.

2.6.3. Creating the Boundary

The new boundary will be created and displayed in the current Tecplot frame after you click 
Create. It will be a Tecplot I-ordered zone.

2.6.4. Extracting from a Selected Mesh

This option is activated by selecting a mesh (IJ-ordered zone) to be used for extracting the new 
boundary. On the Boundary menu, select Extract From Selected Mesh. This will call up the 
Extract Selected Mesh dialog, shown in Figure 2-10.

Figure 2-10. The Extract Selected Mesh dialog.
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In the Line Definition area of the dialog you must enter the starting and ending indices, and the 
specific boundary of the mesh from which you want to extract the new boundary. The indices 
are entered into the Start and End text fields.

Boundary Line options are:

• IMin line: The new boundary is extracted along the I=1 line. Input indices are indices for J 
points.

• IMax line: The new boundary is extracted along the I=IMax line. Input indices are indices 
for J points.

• JMin line: The new boundary is extracted along the J=1 line. Input indices are indices for 
I points.

• JMax line: The new boundary is extracted along the J=JMax line. Input indices are indices 
for I points.

No node distribution changes are allowed when extracting. The only editing permitted on an 
extracted line is the modification of the starting and ending indices and the Boundary Line 
option. Valid values for both starting and ending indices are from 1 to the maximum number of 
nodes (designated by Mx, or the actual J-index) in either the I- or J-direction of the selected 
mesh. For further information about values for the indices, see Section 2.1.1.3, “Using a Subset 
of the Specified Control Points.”

2.6.5. Labeling the Boundary

A name can be assigned to each boundary you create. This simplifies boundary selection when 
choosing from a list to create your mesh. You may enter any characters you wish in the Line 
Label text field.

2.6.6. Creating the Boundary

The new boundary will be created and displayed in the current Tecplot frame after you click 
Create. It will be a Tecplot I-ordered zone. The Extract Selected Mesh dialog will be removed 
after you click OK or Cancel.

To demonstrate this feature we will continue the blunt body example we last changed in 
Section 2.5.3, “Creating the Boundary.” We will divide the boundary line into two parts. To do 
this, perform the following steps:



2.7. Distributing Nodes Along the Boundaries
1. Using the Tecplot Selector tool, select boundary line b10 in the current Tecplot frame. Now 
click on the Boundary menu and select Extract From Selected Line. This will call up the 
Extract Selected Line dialog.

2. On the Extract Selected Line dialog, set Start to 1 and End to 30. Use the Line Label text 
field to name this boundary “b11,” then click OK. A new boundary will appear on top of 
the first half of b10.

3. Now select b10 using the Tecplot Selector tool again, and click on the Boundary menu to 
select Extract From Selected Line. This will call up the Extract Selected Line dialog again.

4. On the Extract Selected Line dialog, set Start to 30 and End to 59. Use the Line Label text 
field to name this boundary “b12,” then click OK. A new boundary will appear on top of 
the first half of b10.

2.7. Distributing Nodes Along the Boundaries

Mesh Generator provides several options for specifying how nodes are to be distributed along 
your boundary lines. The distribution options allow you to concentrate the nodes near the ends 
of boundary lines, and near specific locations along the boundaries. To call up the Node Distri-
bution dialog, click Node Distribution on either the Polyline, Circular Arc, or the Conic Arc 
dialogs. These may be accessed from the Boundary menu.

2.7.1. Node Distribution

The Distribution option on the Node Distribution dialog makes other areas on the dialog active 
or inactive, depending upon the selection. Available Distribution options are:

• As Is: Do nothing and copy the current node distribution.

• Even Spacing: Nodes are distributed evenly with constant spacing.

• Exponential (One- or Two-Sided): Nodes are distributed in terms of an exponential func-
tion. The default value is Two-Sided, where the Initial and Final Spacing are set to 0.001. 

- When One-Sided (Initial) is selected, the Initial Spacing is required and clustering will 
occur near the starting point of the line. 

- When One-Sided (Final) is selected, the Final Spacing is required and clustering will 
occur near the ending point of the line.

• Tanh: Nodes are distributed with a hyperbolic tangent where clustering will be done at 
both ends of the line. Tanh is similar to the exponential distribution, but, the stretching is 
more gradual near the end points. Both Initial and Final Spacing is required.
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• Multiple Tanh: Nodes are distributed in a series of hyperbolic tangent functions. The result 
is a series of segments with the mesh stretched toward the end of each segment.

Selecting Multiple Tanh distribution will activate the Multiple Tanh area, located immedi-
ately below the Distribution dropdown. In it, you must specify at least one clustering con-
trol point, the spacing near this point, and the number of nodes before this point. The 
clustering point control is similar to the Polyline dialog, where the list is for the selection of 
clustering information. The text fields in the Multiple Tanh area are to enter or modify the 
values, and Replace, Add, and Delete are the available action buttons. Both the Initial and 
Final Spacing, as well as at least one clustering spacing is required. When only one cluster-
ing control point is entered, the resulting line will have two segments where the clustering 
will be at both ends, as well as at the clustering point.

• Polynomial (One- or Two-Sided): Nodes are distributed with a cubic polynomial for the 
Two-Sided option, or a polynomial function in the X-coordinate for the One-Sided option. 
The default value for Two-Sided is Initial and Final Spacing set to 0.001.

- When One-Sided (Initial) is selected, the Initial Spacing is required and the clustering 
will occur near the starting point of the line.

- When One-Sided (Final) is selected, the Final Spacing is required and the clustering will 
occur near the ending point of the line.

2.7.2. Number of Nodes

The number of nodes to be distributed along the created boundary must be specified. This 
value is entered in the Number Of Nodes text field. The number of nodes includes the first and 
last nodes. Valid numbers are any integer number. If the Node Distribution option is set to As 
Is, the only valid entry for Number Of Nodes is that equal to the number of Control Points 
listed Line Definition.

2.7.2.1. Line Direction/Reverse Line Direction. The Reverse Line Direction check box 
enables you to switch the direction of the node index order along a boundary when it is created. 
It has no effect on the node distribution.

The default direction of the node index order is from starting to ending point of a line accord-
ing to the order of the Control Points in the Line Definition area of the Polyline dialog. Revers-
ing the line direction does not affect how the nodes are distributed, as it is based upon the line 
direction defined by your control points. Instead, reversing the line direction occurs after the 
nodes have been distributed along the created boundary.



2.7. Distributing Nodes Along the Boundaries
2.7.3. Node Spacing

For the Exponential, Tanh, Multiple Tanh, and Polynomial Distribution options, you are 
required to enter values for the Initial and Final Spacing. For the One-Sided options only the 
Initial or Final Spacing is required.

Spacing is the distance between two adjacent nodes. Initial Spacing is the spacing at the first 
node (index=1), and Final Spacing is the spacing next to the last node. The spacing between 
the nodes depends upon your distribution option. The values you enter in the Initial and Final 
Spacing text fields on the Node Distribution dialog must be entered in units consistent with the 
physical coordinates. The default values are set to 0.001.

2.7.3.1. Multiple Tanh. The Multiple Tanh area of the Node Distribution dialog is active 
only when Distribution is set to Multiple Tanh. This area contains a list of cluster control 
points, text fields for entering these points, and buttons for controlling the points. The cluster-
ing control point list is used to control the clustering information. Initially, this list will be 
empty. In addition to the Initial and Final Spacing values, you must specify at least one addi-
tional clustering control point by entering the values in the four Multiple Tanh text fields; X, Y, 
Spacing, and # Nodes. The clustering points may be entered in any order, and are sorted by dis-
tance along the line starting from the first control point.

Figure 2-11 illustrates a line defined by five control points and Interpolation set to Cubic. This 
demonstrates how the cluster points divide the line into sections.

The sorting places the cluster points on the line in the order 1, 3, 2, to create four line sections, 
though the order in which the points would appear in the list is 1, 2, 3. For the purpose of defin-
ing the sections, the starting and ending points on the line are considered to be clustering 
points.

The values for X and Y are the approximate coordinates along the boundary line at which the 
clustering is to be focused. The actual coordinates will be calculated by determining the point 
on the line closest to the values you enter. Spacing at this clustering point is enforced on both 
sides of the point. The # Nodes is the number of the nodes to be placed on the line section 
between two physically adjacent clustering points, including the clustering points.

In Figure 2-11 the # Nodes in section 1 is four, since the section contains four mesh nodes, 
including the nodes that are automatically placed at the clustering points at the ends of the sec-
tion. The # Nodes for the last section, which is section 4 in this case, cannot be specified by the 
user. This section is self-defined by the last cluster point and the last point on the line. The 
number of nodes placed in this section is calculated in such a way that the total number of 
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nodes on the line will be equal to Number Of Nodes. The text fields are used to modify the 
values.

Replace, Add, and Delete are the available option buttons. The Add button will add your 
entered values to the list below the selected point. If the list is empty, it will list your values. If 
the list is empty and you have not selected a point, clicking Add will call up a warning mes-
sage, indicating that you must select a point. The Replace button will replace a selected point 
with the entered values. The Delete button will remove a selected point from the list.

2.7.4. Interpolation

The Interpolation area of the Node Distribution dialog lets you select the type of interpolation 
which will be used to control the polyline boundary shape while distributing nodes along it. 
The interpolation is based on the specified control points.

There are two Interpolation options available:

Figure 2-11. Cluster points dividing a line into sections.

X

Y

0 0.2 0.4 0.6 0.8 1 1.2
0

0.2

0.4

0.6

0.8

Line Control Points

Node Points

Clustering Points

1

3

2

Se
ct

io
n

1

Section 2
Section 3

Section 4



2.8. Editing a Selected Line
• Cubic (the default).

• Linear.

No interpolation will be performed for NURB lines, circular or conic arcs, as they are treated 
analytically.

The following example creates a boundary with a multiple hyperbolic tangent node distribu-
tion, similar to that shown in Figure 2-11. To create the boundary, perform the following steps:

1. Using the Tecplot polyline geometry tool, draw a polyline with four segments. (This will 
require five clicks on your mouse, which will create five control points.)

2. Now use the Tecplot Selector tool to select the polyline, then click on the Boundary menu, 
and select Create Polyline. This will call up the Polyline dialog.

3. On the dialog, click Convert Polyline Geometry Insert After. This will enter the values of 
your polyline into the Control Points list.

4. Now click Node Distribution. On the Node Distribution dialog, set Distribution to Multiple 
Tanh, Number Of Nodes to 31, and Initial and Final Spacing to 0.01. Now create three clus-
ter points by setting X- and Y-values that approximate positions along the new line, set 
Spacing to 0.01, and set # Nodes to 4 for the first segment, 7 for the second segment, and 6 
for the third segment. Click Add after entering the values for each cluster point. Set Interpo-
lation to Cubic. Click OK.

5. On the Polyline dialog, use the Line Label text field to name this boundary “b13,” and click 
Create. The new boundary line will appear in the current Tecplot frame.

Note: If your new boundary line does not look like that in Figure 2-11, you may wish to click 
on the Scatter plot layer button on the Tecplot sidebar.

2.8. Editing a Selected Line

To edit a line, select it using the Tecplot Selector tool, then choose Edit Selected Line from the 
Boundary menu.

The option is activated only when you select a line in the current Tecplot frame. The dialog 
which results will depend upon the type of line you have selected. Available options are:

• Created polyline: Polyline dialog is called up.

• Created circular arc: Circular Arc dialog is called up.

• Created conic arc: Conic Arc dialog is called up.
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• Created by extraction from a line: Extract From Selected Line dialog is called up.

• Created by extraction from a mesh: Extract From Selected Mesh dialog is called up.

• NURB line: NURB curve dialog is called up.

• All other lines: Polyline dialog is called up.

Any of the input values in these dialogs can now be edited. A new boundary will replaced the 
selection, and will be displayed in the current Tecplot frame after you click Replace. The 
dialog will then be reset with its default values.

2.9. Deleting a Selected Line

To delete a line you have selected, click Delete Selected Line from the Boundary menu. The 
selected line will only be deleted if it is not used in other zones, otherwise, an error message 
will be displayed.

2.10. Displaying Selected Line Information

Clicking Selected Line Info, accessed from the Boundary menu, will call up the Line Info 
dialog. This is shown in Figure 2-12.

Selected information about a boundary you have selected in the current Tecplot frame is dis-
played here. The Line Info dialog lists zone number, the user or system defined label, and type 
of boundary, such as polyline or circular arc. It also lists the number of control points, the start-
ing and ending node indices, the number of the currently selected node, total number of nodes, 
and IMin and IMax spacing. IMin spacing reports the distance between the boundary’s first and 
second node. IMax spacing reports the distance between the last and second to last nodes of the 
boundary.



2.10. Displaying Selected Line Information
Figure 2-12. The Selected Line Info dialog.
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CHAPTER 3 Creating Structured 
Meshes

Mesh Generator features three methods of generating structured meshes: Algebraic, Elliptic, 
and Hyperbolic.

Algebraic methods used in Mesh Generator are based on transfinite interpolation (TFI). These 
are very fast and usually generate meshes directly acceptable for calculations.

Elliptic methods used in Mesh Generator are based on iterative solution of Poisson’s equation. 
They are often used to improve on the quality, the orthogonality, and to smooth minor irregu-
larities of algebraic meshes. 

The Hyperbolic method used in Mesh Generator is based on the advancing front method, fol-
lowed by an elliptic smoothing. This method sequentially marches along a set of mesh lines. 
Elliptic smoothing is only used to smooth and relax any irregularity on each step. This is a very 
fast and robust method for generating external meshes.

As a special output option, the resulting structured meshes may be converted into a single 
quadrilateral or triangular unstructured mesh. You may choose to use different mesh generation 
methods in different zones

3.1. Creating Algebraic or Elliptic Meshes

Algebraic and elliptic meshes are defined by selecting the boundary lines that form the four 
boundaries (IMin, IMax, JMin, and JMax) of a mesh zone (block). A hyperbolic mesh is 
defined by selecting boundary lines which form the JMin boundary.
45



Chapter 3. Creating Structured Meshes

46
3.1.1. Specifying Boundaries

Algebraic and elliptic structured mesh generation requires that all four boundaries (IMin, 
IMax, JMin, and JMax) surrounding the mesh be specified. Each boundary consists of one or 
more boundary lines.

If a boundary is composed of more than one boundary line, all lines for this boundary are con-
catenated to form a single line. The direction of increasing node index is determined by the 
first line selected in the boundary. Line sections defining a boundary must be added in the 
order in which they form the boundary. For example, the second line selected will be connected 
to the first line, the fifth line selected will be connected to the first, second, third, and fourth 
lines. Mesh Generator requires that each sequential line used in the formation of a mesh 
boundary share a common node with the previous line. 

The number of nodes in both the I- and J-directions is determined by the number of nodes in 
the corresponding boundaries. The number of nodes for the IMin boundary must equal the 
number in the IMax boundary; likewise for the JMin and JMax boundaries. The nodes must be 
coincident at the four corner points formed by the boundaries. The direction of increasing node 
index must be the same in IMin and IMax boundaries. Similarly, the JMin and JMax bound-
aries must share the same direction of increasing node index. 

Algebraic and Elliptic meshes are created with the Algebraic/Elliptic Structured dialog. This is 
called up by selecting Create Algebraic/Elliptic Structured from the Mesh menu. The Alge-
braic/Elliptic Structured dialog is shown in Figure 3-1.

The lines selected to define boundaries are shown by zone numbers in the text fields labeled 
IMin, IMax, JMin, and JMax corresponding to the four boundaries of the mesh. Lines may be 
selected in one of three ways: 

• If a line is selected using the Tecplot Selector tool, the button next to the IMin, IMax, JMin,  
and JMax text fields reads Add Selected. Clicking the appropriate button will add this line 
segment’s zone number to the corresponding text field.

• If no line is selected, the button next to the IMin, IMax, JMin, and JMax text fields reads 
Add From List. Clicking this button invokes the Add From List dialog with a multi-selec-
tion list of line segment zone numbers and names. One or more of these items are selected 
in the usual way (click, Ctrl-click, or shift-click). Clicking OK adds the zone numbers of 
the selected line segments to the appropriate text field.

• The zone numbers of the lines may be manually entered directly into the IMin, IMax, JMin, 
or JMax text fields. 



3.1. Creating Algebraic or Elliptic Meshes
Once you have defined the boundaries for a mesh, you may select any of the three algebraic 
methods to generate a structured mesh. 

3.1.2. Algebraic Mesh Control

There are six mesh control methods in the Mesh Control section of the Algebraic/Elliptic 
Structured dialog. These are Algebraic-Arclength, Algebraic-Linear, Algebraic-Edge.Ortho, 
Elliptic-Laplace, Elliptic-Thomas, and Elliptic-Orthogonal. The first three mesh control 
methods are algebraic meshes. These are:

• Algebraic-Arclength: Mesh nodes are interpolated using arc-length distances from the 
boundary nodes. This generally yields a better mesh than the other two options, particularly 
when the boundaries have curvature. Therefore, it is used as the default. 

Figure 3-1. The Algebraic/Elliptic Structured dialog.
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• Algebraic-Linear: This uses standard linear interpolants for transfinite interpolation, 
which usually results in satisfactory meshes.(However, mesh lines may cross when using 
this method on highly curved boundaries.

• Algebraic-Edge.Ortho: This uses a blending function similar to Algebraic-Arclengh, with 
additional constraints added to make the mesh orthogonal at the boundaries. 

When an algebraic mesh control option is selected, all other mesh control parameters are inac-
tive.

3.1.3. Labeling an Algebraic Structured Mesh

A name can be assigned to each mesh you create. The Mesh Label text field is located at the 
bottom of the Algebraic/Elliptic Structured dialog, you may enter any characters you wish.

3.1.4. Creating an Algebraic Structured Mesh

Clicking on the Create button will generate the new algebraic structured mesh. The Working 
dialog will appear while the new mesh is generated. When done, the new mesh will be dis-
played in the current Tecplot frame and added to its data set as an IJ-ordered zone.

Note: During the recording of a macro or project file, a Cancel request is not recorded.

For an example of Algebraic Structured mesh creation, see Section 1.3.3, “Creating the Mesh.”

3.1.5. Elliptic Mesh Control

The last three methods listed in the Method dropdown in the Mesh Control area of the Alge-
braic/Elliptic Structured dialog are fore Elliptic meshes. These are:

• Elliptic-Laplace: Solves the Laplace equation. This method is useful for generating evenly 
spaced meshes. When this method is used for stretched meshes, it will try to even the mesh 
spacing, which may be undesirable. Selecting this method requires two other mesh control 
parameters: Maximum Iterations and Elliptic Relaxation.

• Elliptic-Thomas: Solves Poisson’s equation with source terms added to retain the stretch-
ing near the walls. This option is useful for generating stretched meshes. Selecting this 
method also requires the Maximum Iterations and Elliptic Relaxation parameters. 



3.1. Creating Algebraic or Elliptic Meshes
• Elliptic-Orthogonal: Solves Poisson’s equation with source terms added to force the mesh 
to be nearly orthogonal near the walls. Selecting this method requires the Maximum Itera-
tions, Elliptic Relaxation, and Orthogonality Relaxation parameters. 

When any of the three elliptic control options are selected, the initial mesh will be created 
using the Algebraic-Arclength option.

The parameters in the Mesh Control area of the Algebraic/Elliptic Structured dialog are:

• Maximum Iterations: Specifies the maximum number of elliptic iterations to perform for 
mesh generation. 

• Elliptic Relaxation: Specifies the relaxation factor for the successive-over-relaxation 
(SOR) method of solving Poisson’s equation. Increasing this parameter will improve the 
rate at which the iterative SOR converges. However, it may also make it less stable. 
Decreasing this parameter makes the relaxation more stable, but reduces the convergence 
rate. When the elliptic iteration is unstable, it is common to reduce this parameter. 

• Orthogonality Relaxation: A normalized distance (I divided by IMax and J divided by 
JMax) where the orthogonality condition is relaxed to ten percent of its value at the bound-
ary. This condition is applied to both the I and J directions. The lower the value is, the larger 
the region of equi-spacing in the middle of the mesh. If this value is too small (for example, 
0.01), the elliptic solver may be less stable due to large gradients in the control function 
near the boundaries. 

3.1.6. Labeling an Elliptic Structured Mesh

A name can be assigned to each mesh you create. The Mesh Label text field is located at the 
bottom of the Algebraic/Elliptic Structured dialog, you may enter any characters you wish.

3.1.7. Creating an Elliptic Structured Mesh

As a comparison, we will now mesh our blunt body shape with an Elliptic-Orthogonal mesh. 
You can see Section 1.4.2, “Modifying Meshes,” for more information on Mesh Generator’s 
mesh modification options. To create a Elliptic-Orthogonal mesh, perform the following steps:

1. Click on the existing mesh labeled laplace, then go to the Mesh menu. From the list, click 
Delete Selected Mesh.
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2. Now we must change the node distribution on the JMin boundaries, b1 and b2. Click on a 
node on b1 with the Tecplot Selector tool. Now choose Edit Selected Line from the Bound-
ary menu. The Circular Arc dialog will be called up. Click Node Distribution. Set Distribu-
tion to Even Spacing, then click OK. On the Circular Arc dialog click Replace. Close the 
dialog.

3. Using the Tecplot Selector tool click on a node on b2. Choose Edit Selected Line from the 
Boundary menu. The Polyline dialog will be called up. Click Node Distribution. Set Distri-
bution to Even Spacing, then click OK. On the Polyline dialog click Replace. Close the dia-
log.

4. From the Mesh menu, choose Create Algebraic/Elliptic Structured. Add boundaries as indi-
cated: b3 for IMin, b4 for IMax, b1 and b2 for JMin, b5 for JMax. In the Mesh Control area 
of the dialog, set Method to Elliptic-Orthogonal, and accept its default values. Use the 
Mesh Label text field to name the new mesh “orthogonal” and click Create. The Working 
dialog will appear while the new mesh is generated. When done, the new mesh will be dis-
played in the current Tecplot frame and added to its data set as an IJ-ordered zone.

The resulting mesh is shown in Figure 3-2.

Figure 3-2. The Elliptic-Orthogonal mesh.
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3.2. Creating Hyperbolic Meshes
The working dialog features a Cancel button. Clicking Cancel stops the mesh generation at the 
last iteration but does not delete the new mesh zone.

Note: During the recording of a macro or project file, a Cancel request is not recorded.

3.2. Creating Hyperbolic Meshes

Hyperbolic meshes are created by marching a single JMin boundary in a direction normal to 
itself, to add a specified number of additional mesh lines. The end points of the boundary can 
be unconstrained, constrained to a line of constant X or Y, or connected to each other (peri-
odic). The JMin boundary may consist of one or more other boundary lines, which will be con-
catenated to form a single boundary when the mesh is created. The direction of increasing I-
index on the JMin boundary is determined by the first boundary line selected. Boundary lines 
defining a hyperbolic boundary must be added in the order that they form the boundary. Mesh 
Generator requires that each sequential line section used in the formation of a boundary to 
share a common node with the previous line section. 

3.2.1. Specifying Boundaries

The boundary lines selected to define the JMin edge are shown by zone numbers in the text 
fields labeled JMin. Line segments may be selected in one of three ways: 

• If a line is selected using the Tecplot Selector tool, the button next to the JMin text field 
reads Add Selected. Clicking the appropriate button will add this line’s zone number to the 
corresponding text field.

• If no line is selected, the button next to the JMin text field reads Add From List. Clicking 
this button invokes the Add From List dialog with a multi-selection list of line segment 
zone numbers and names. One or more of these items are selected in the usual way (click, 
Ctrl-click, or shift-click), and clicking OK adds the zone numbers of the selected line seg-
ments to the appropriate text field. (Zone numbers are added in the increasing order in the 
text field.)

• The zone numbers of the line segments may be manually entered directly into the JMin text 
field. 

Hyperbolic meshes are created with the Hyperbolic Structured dialog, shown in Figure 3-3. 
The dialog is called up by choosing Create Hyperbolic Structured from the Mesh menu.
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3.2.2. Hyperbolic Mesh Control

The # Layers (JMax) text field on the Hyperbolic Structured dialog indicates the total number 
of mesh lines in the J-direction (the marching direction), including the JMin boundary. The 
Initial Spacing text field indicates the spacing between the JMin boundary and the first gener-
ated mesh line. Total Distance is the approximate normal distance between the JMin boundary 
and the last added mesh line (JMax boundary). Both of these must be positive numbers, and the 
value for Total Distance must be greater than that in Initial Spacing. 

At the IMin and IMax limits of the hyperbolic zone, you may impose one of the following 
boundary constraints:

• None: These boundaries evolve as the mesh is marched. 

Figure 3-3. The Hyperbolic Structured dialog.



3.2. Creating Hyperbolic Meshes
• X=Constant: The boundary is constrained to a line of constant X value, using the X at that 
end of the JMin boundary.

• Y=Constant: The boundary is constrained to a line of constant Y value, using the Y at that 
end of the JMin boundary.

• Periodic: The end points of the boundary (I=1 and I=IMax) are checked to insure that they 
are coincident. 

Max. Smoothing Passes is a parameter related to an elliptic relaxation performed on each new 
mesh line. Each new line is created by a hyperbolic marching scheme, then a second “ghost” 
layer is added by reflecting the previous line across the new line. The node positions in the new 
line are then relaxed according to an elliptic equation, using the previous layer and the ghost 
layer as boundaries. Max. Smoothing Passes indicates the maximum number of relaxation iter-
ations the generator will use in the relaxation. Enter 0 for a purely hyperbolic scheme, or a pos-
itive number to allow relaxation to occur. Default value for this parameter is set to be 100. 
Generally, the more convoluted the geometry, the larger the number of smoothing passes. The 
node positions in the new line are then relaxed according to an elliptic equation, using the pre-
vious layer and the ghost layer as boundaries. 

The Reverse Marching Direction check box is used to reverse the direction normal of the 
marching. The default direction proceeds to the left of the JMin boundary. Selection this option 
will cause the marching to proceed to the right of the JMin boundary.

The Replace and Remove 1 Layer buttons are only active when Edit Selected Mesh is chosen. 
The Remove 1 Layer option allows you to remove the last layer of mesh.

3.2.3. Labeling a Hyperbolic Structured Mesh

A name can be assigned to each mesh you create. The Mesh Label text field is located at the 
bottom of the Hyperbolic Structured dialog, you may enter any characters you wish.

3.2.4. Creating a Hyperbolic Structured Mesh

To create a Hyperbolic Structured mesh from your existing blunt body shape, perform the fol-
lowing steps:

1. Choose Create Hyperbolic Structured from the Mesh menu. 

2. Use either Add From List or Add Selected next to the Enter Mesh Boundary Zone Numbers 
text field to enter your JMin boundary. In this case we will use the JMax boundary. Select 
b5, to be our new JMin boundary.
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3. In the Mesh Control area of the Hyperbolic Structured dialog, set the following values. For 
# Layers (JMax) enter 50. For Total Distance enter 2. In Constraints, use the IMin drop-
down to set Y=Constant. Finally, use the Mesh Label text field to name the new mesh 
“hyperbolicy.” Click Create. The Working dialog will appear while the new mesh is gener-
ated. When done, the new mesh will be displayed in the current Tecplot frame and added to 
its data set as an IJ-ordered zone.

The resulting mesh is shown in Figure 3-4.

The working dialog features a Cancel button. Clicking Cancel stops the mesh generation at the 
last iteration but does not delete the new mesh zone.

Note: During the recording of a macro or project file, a Cancel request is not recorded. If a 
project file is saved at this point, however, only the number of layers actually generated will be 
saved in the file.

Figure 3-4. The Hyperbolic Structured mesh.
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3.3. Editing and Deleting Structured Meshes
3.3. Editing and Deleting Structured Meshes

To edit a mesh, you may select it in the current Tecplot frame, and then choose Edit Selected 
Mesh from the Mesh menu. Depending upon the type of mesh you have selected, either the 
Algebraic/Elliptic Structured or Hyperbolic Structured dialog will be called up. Edit Selected 
Mesh is only active when the mesh you have selected was created by Mesh Generator.

To edit the Hyperbolic Structured mesh you have created, perform the following steps:

1. Select the hyperbolicy mesh in your current Tecplot frame with the Selector tool, then 
choose Edit Selected Mesh from the Mesh menu.

2. In the Mesh Control area of the Hyperbolic Structured dialog, set Total Distance to 3, and 
use the IMin drop-down to set the value as X=Constant. Set Max. Smoothing Passes to 0. 

3. Finally, use the Mesh Label text field to name the new mesh “hyperbolicx.” Click Replace. 
The Working dialog will appear while the mesh is regenerated. When done, the new mesh 
will be displayed in the current Tecplot frame and added to its data set as an IJ-ordered 
zone.

The resulting mesh is shown in Figure 3-5.

When either the Algebraic/Elliptic Structured or Hyperbolic Structured dialog is called up to 
edit a two-dimensional mesh, the Replace button will be active. Clicking on the Replace button 
will not generate the new IJ-ordered zone, it will only replace the current zone. 

The Delete Selected Mesh option on the Mesh menu is only active when you select a two-
dimensional mesh in the current Tecplot frame. It will delete the mesh you have selected only 
if it is not used in any of existing zones. Otherwise, an error message will appear. 

3.4. Mesh Connectivity

Multi-block flow solvers analyzing multiple zones must be instructed on how mesh zones are 
connected to one another in order to come up with the correct solution. When two meshes are 
not contiguous you cannot instruct a flow solver to treat the two mesh zones as a single region. 

There are two ways to automatically create mesh connectivity in the Mesh Generator, such that 
the mesh points on the connecting boundary will be exactly coincident. The first is to use the 
same boundary line for the two meshes you wish to connect, which will be discussed shortly. 
The second method is to extract a boundary line from an existing mesh, which is covered under 
Section 2.6, “Extracting New Boundaries.”
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Note: You can only use Tecplot mesh files to specify various types of mesh connectivity when 
outputting the mesh. The restricted format of PLOT3D files cannot store this information. For 
a discussion of how connectivity is written into Tecplot mesh files, see Chapter 5, “Exporting 
Meshes.”

To create a simple connected mesh from our existing example, perform the following steps:

1. In the Polyline dialog, enter the values 5, 0, for X and Y in the X and Y text fields. Click 
Insert Before. Now enter 5 for X and 1 for Y. Click Insert After. Click Node Distribution 
and set Distribution to Even Spacing and Number Of Nodes equal to 5 on the Node Distri-
bution dialog. On the Polyline dialog, use the Line Label text field to name this boundary 
“b6.” Click Create. The new boundary will be drawn in your current Tecplot frame. Close 
the Polyline dialog.

Figure 3-5. The modified Hyperbolic Structured mesh.
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3.4. Mesh Connectivity
2. Under Mesh on the Mesh Generator menu, choose Create Hyperbolic Structured from the 
menu. You may either use Add From List to specify the JMin boundary of the mesh, or you 
may select boundaries with the Selector tool, which will change the button to read Add 
Selected. Use either method to add b6 and b4 as the JMin boundary. Note that because the 
b6 boundary has the lower I-index values, you must list it before b4.

3. Click in the Reverse Marching Direction check box so that the new mesh will not overlay 
the existing mesh.

4. Accept the other default values, then use the Mesh Label text field to name the new mesh 
“connected,” then click Create. The Working dialog will appear while the new mesh is gen-
erated.

5. From the Tecplot menu bar, select the View menu, then select the Data Fit option to display 
all of the newly created boundary line.

The resulting mesh is shown in Figure 3-6.

Figure 3-6. The connected Hyperbolic Structured mesh.
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CHAPTER 4 Creating 
Unstructured Meshes

In Mesh Generator, an unstructured mesh is formed by filling a boundary-enclosed area with 
triangular mesh cells. One outer boundary must be specified to enclose the mesh, while an 
arbitrary number of inner boundaries may be specified to “cut out” portions of the mesh. Inner 
boundaries generally represent geometries, such as an airfoil in a flow field.

4.1. Selecting Closed-Loop Boundaries

Unstructured meshes are created by clicking on the Mesh menu, then selecting Create Unstruc-
tured. The Unstructured dialog is called up, as shown in Figure 4-1.

Each closed-loop boundary may consist of more than one boundary line. The outer boundary, 
along with any inner boundaries, are specified in the Closed-Loop Boundaries area on the 
Unstructured dialog. Each text line in the Select Mesh Boundary Zone Numbers list represents 
one boundary. To add a boundary to the list, click New Boundary. This will generate a high-
lighted empty line shown as (Incomplete) in the field. You may select and use more than one 
boundary line to make up this boundary. Lines may be chosen in one of two ways: 

• If no boundary line is selected, the button below New Boundary will read Add From List. 
Clicking on this button calls up the Add From List dialog. This lists all the boundary lines 
available for use in the closed-loop boundary. You may select one or more boundary lines 
to be added to the list. Clicking OK will add their zone numbers to the list.

• If a boundary line is selected using the Tecplot Selector tool, Add From List will change to 
read Add Selected. Clicking Add Selected will add the selected line’s zone number to the 
list. 
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All boundary lines for a boundary are concatenated to form a single line. The direction of 
increasing index for the boundary is determined by the first line selected. Boundary lines defin-
ing this boundary must be added in the order that they form the boundary. 

Mesh Generator requires each sequential boundary line used in the formation of a boundary to 
share a common node with a previous line. Each boundary must form a closed-loop. Once the 
last node of a particular boundary coincides with the first node of the same boundary, this 
boundary is a complete closed-loop. Boundary lines may no longer be added. 

The direction of the closed-loop boundary is important. The outer boundary must proceed 
counter-clockwise around the mesh, while inner boundaries must be clockwise. Mesh Genera-
tor will determine whether a boundary is external or internal once it is a closed-loop. An exter-
nal boundary (counter-clockwise) will have a (Ext-Boundary) label in the list, while an internal 
boundary will have a (Int-Boundary) label.

Figure 4-1. The Unstructured dialog.



4.2. Unstructured Mesh Control
Once it is determined whether a boundary is external or internal, the direction of the boundary 
may be reversed by clicking in the Reverse Direction checkbox. An external boundary will 
become internal, and vice versa. The boundary’s label will be changed accordingly.

To create a mesh with more than one closed-loop boundary, you may click on the New Bound-
ary button as many times as desired. Boundaries may be added in any order. 

To remove a boundary from the list, select it, then click Delete. To edit a boundary you must 
first remove it, then create a new boundary.

4.2. Unstructured Mesh Control

The Maximum # Cells text field indicates the maximum number of triangular cells which will 
be used to fill an enclosed region. This number must be greater than the total number of bound-
ary nodes (external and internal boundaries), or an error will be displayed. 

It is recommended you not set this number too large, or it may result in the unnecessary usage 
of memory. The mesh density created by Mesh Generator depends solely on the node distribu-
tion along the boundaries. The denser the boundary, the denser the resulting mesh will be. 

The Mesh Smoothing check box gives you the ability to use a Laplacian-type smoothing oper-
ator to smooth small irregularities. 

A name can be assigned to any mesh you create. The Mesh Label text field is located at the 
bottom of the dialog, you may enter any characters you wish.

Clicking Create will create a new unstructured zone and add it to the data set of the current 
frame. The initial boundary triangulation will be shown in the current frame, then refreshed 
after each100 points have been inserted. You may interrupt mesh creation by clicking Cancel 
on the Working dialog.

4.3. Editing and Deleting Unstructured Meshes

Select the desired unstructured mesh to edit, then click Edit Selected Mesh from the Mesh 
menu. The Unstructured dialog will be called up. This option is only active when the selected 
unstructured mesh was created using Mesh Generator. 

Clicking Replace will replace the selected unstructured mesh zone with a newly created mesh. 
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Clicking Create will generate the new unstructured zone and add it to the data set of the current 
frame. 

The Delete Selected Mesh option is active only when you select a two-dimensional unstruc-
tured mesh in the current Tecplot frame. Clicking on it will remove the unstructured mesh you 
have selected.

4.3.1. Unstructured Mesh Creation

To create a simple unstructured mesh, we will use our existing blunt body. Before starting, use 
the Delete Selected Mesh and Delete Selected Line options from the Mesh and Boundary 
menus to remove the meshes we have created so far, and boundary line b6, created in Section 
3.4, “Mesh Connectivity.” Once you have the original blunt body configuration, perform the 
following steps:

1. Using the Tecplot circle geometry tool, create a circle around the blunt body. To do this, put 
the circle geometry crosshair in the center of the blunt body, then click and drag to form a 
circle which encompasses the blunt body.

2. Select the circle with the Tecplot Selector tool, then select Create Circular Arc from the 
Boundary menu. 

3. On the Circular Arc dialog, click Convert Circle Geometry. This will enter the coordinates 
of the circle you have just drawn into the text fields on the Circular Arc dialog. Accept all 
other default values, then use the Line Label text field to name this “circle1.” Click Create.

4. From the Mesh menu, select Create Unstructured. On the Unstructured dialog, click New 
Boundary, then Add From List. Add the boundary lines in the following order: b1, b2, b4, 
b5, and b3. Click Reverse Direction. 

5. Click New Boundary again, followed by Add From List. Add circle1 to your second bound-
ary. Click Reverse Direction again. We have now specified that the boundaries of our blunt 
body will be the interior boundary for this mesh, and our circle will be the exterior bound-
ary.

6. Use the Mesh Label text field to name this “unstructured,” then click Create.

The resulting mesh is shown in Figure 4-2.



4.3. Editing and Deleting Unstructured Meshes
Figure 4-2. The Unstructured mesh.
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CHAPTER 5 Exporting Meshes

Mesh Generator allows you to save mesh zones you create in PLOT3D format or in an aug-
mented Tecplot format which contains boundary and inter-zone connection information. You 
may specify ASCII or binary. You also have the option of combining mesh zones into a single 
unstructured zone (triangular or quadrilateral) for use with software which requires purely 
unstructured meshes.

5.1. Selecting the Format

All mesh output options are available in the Mesh Output dialog, shown in Figure 5-1. This 
dialog is called up when you select Write Mesh File from the File menu.

The Format drop-down on the Mesh Output dialog allows you to select between Tecplot and 
PLOT3D (FAST) file formats. Two option buttons just below this menu allow you to specify 
ASCII or binary. ASCII is recommended for PLOT3D files, if you wish to move between dif-
ferent architectures (Windows and UNIX, or different UNIX platforms). ASCII is also recom-
mended for the Tecplot file format, since software reading the mesh may not be able to read 
binary Tecplot files. 
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5.1.1. The Tecplot Format

The Tecplot mesh file format is a standard Tecplot data file augmented with boundary informa-
tion (including inter-mesh connections). As such, it may be read directly into Tecplot for view-
ing. Refer to the Tecplot User’s Manual for details on this file format. Binary Tecplot mesh 
files are written in double precision.

Boundary information is contained in USERREC fields, described below. These fields are used 
to describe boundary regions on both structured and unstructured meshes. Connections 
between meshes are identified by associating two of these regions.

Each boundary line used to create a zone becomes a boundary region in the mesh file. For 
example, if two such lines form the JMin boundary for a hyperbolic mesh, then two boundary 
regions will be output for the JMin face of that mesh, one corresponding to each boundary line. 
Each boundary region is assigned the same label as the corresponding boundary (which is also 
the Tecplot zone name for that boundary).

Figure 5-1. The Mesh Output dialog.



5.1. Selecting the Format
If a particular boundary line was used in the boundaries of two meshes, or if a boundary line 
was extracted from one mesh and used in the boundary of another, then those two meshes are 
considered connected together. This information is also placed in the mesh file; see Section 
5.1.1.4, “IZPLABEL”  for further details.

5.1.1.1. The Tecplot USERREC. Tecplot allows arbitrary character information to be 
embedded in data files. In ASCII data files, this information is enclosed in quotation marks, 
and identified with the USERREC keyword:

USERREC=”This is arbitrary information”

These USERREC fields are used to hold all boundary information in Tecplot ASCII and binary 
mesh files.

5.1.1.2. SBPATCH. The SBPATCH USERREC field describes a boundary patch on a struc-
tured mesh. It includes the zone number, a label, the zone face (IMin, IMax, and so on), and the 
first and last nodes of the patch. In an ASCII Tecplot file, it would look like:

USERREC=”SBPATCH 3 Wall 2 1 6”

The first word within the character string, SBPATCH, indicates that this is a boundary patch on 
a structured mesh. The integer which follows this, 3, indicates that this patch is on the third 
mesh within the file (that is, the third mesh of those you chose to output). The next word, Wall, 
is a label by which the patch is identified. This is the label of the corresponding boundary, and 
commonly represents a boundary condition which the analysis software will apply to this 
boundary region.

Following the patch label are three additional integers. The first, 2, indicates that this region 
resides on the J=1 face of the mesh. The second, 1, indicates that this region begins at the first 
node of this face, and the final integer, 6, indicates that the sixth node of the face is the final 
node of the region.

Note: The number 1 indicates the I=1 face, 2 indicates J=1, 4 indicates I=IMax, and 5 indi-
cates J=JMax. In three-dimensional meshes generated by other programs, 3 and 6 would be 
used for the K=1 and K=KMax faces of the mesh.

5.1.1.3. DBPATCH. The DBPATCH USERREC is used to identify a region on the boundary 
of an unstructured mesh. Like the SBPATCH, It contains the zone number of the mesh and a 
label. Following these, it contains the number of cell edges which make up the region, and 
pairs of node numbers which form each cell edge. Since many node numbers may be required, 
follow-on USERRECs may be used to contain them. This is illustrated below:
67



Chapter 5. Exporting Meshes

68
USERREC=”DBPATCH 3 Wall 5”

USERREC=”1 2 2 3 3 4 4 5 5 6”

The first USERREC above identifies that this is a DBPATCH on zone 3. It also uses Wall as its 
label, and specifies that this boundary region contains five cell edges.

The second USERREC contains ten node numbers -- five pairs. The first cell edge is formed by 
nodes 1 and 2, the second by nodes 2 and 3, and so on. These node pairs may be contained in 
many consecutive USERRECs within the file.

5.1.1.4. IZPLABEL. The IZPLABEL USERREC is used to identify by label two boundary 
patches which the analysis software should treat as an inter-mesh zone connection. For exam-
ple, The following USERREC would indicate that the SBPATCH and the DBPATCH defined 
in the two previous sections are connected:

USERREC=”IZPLABEL Wall”

Since inter-mesh zone connectivity is indicated only by label, it is important to use unique 
labels for each boundary which will represent a connection (if your analysis software will be 
using this information).

5.1.2. The PLOT3D Format

PLOT3D and its successor, FAST, support several similar mesh file formats. For structured 
meshes there are two-dimensional and three-dimensional, single- and multi-mesh formats. For 
unstructured meshes, there are single- and multi-zone formats. Any of these may be ASCII or 
binary. Binary files are written in single precision.

Mesh Generator supports two-dimensional and unstructured, single- and multi-zone formats. If 
more than one mesh is being output, the multi-zone format is used. For single zone output, you 
will be prompted to choose single- or multi-zone format. Unlike the Tecplot format, the 
PLOT3D format does not support structured and unstructured meshes in the same mesh file. 
Attempting to write such a hybrid mesh file will result in an error.

Binary PLOT3D files are written using FORTRAN records (FORM=UNFORMATTED), so that 
they are readable by FORTRAN flow solvers. The contents of each record is noted in the fol-
lowing sections. 



5.2. Mesh Conversion
5.1.2.1. The 2D Single-Zone Format. PLOT3D’s two-dimensional mesh file format con-
sists of the I-and J-zone dimensions of the mesh, followed by all of the X-coordinates, then all 
of the Y-coordinates, with the I-index moving fastest.

Binary files contain two records. The first record contains the I- and J-zone dimensions, and 
the second record contains all coordinate data.

5.1.2.2. The Unstructured Format. PLOT3D’s unstructured mesh files contain:

• Three integers: The number of nodes, the number of triangles, and the number of tetrahe-
dra.

• All X-coordinates.

• All Y-coordinates.

• All Z-coordinates.

• The connectivity list for the triangles.

• An integer flag for each triangle.

• The connectivity list for the tetrahedra.

Since Mesh Generator only outputs two-dimensional (triangular) unstructured meshes, the Z-
coordinates will all be zero, and the connectivity list for the tetrahedra will be empty. The 
integer flags for the triangles indicate to FAST what type of boundary each triangle represents. 
This is extraneous in a two-dimensional mesh, so all of these flags are set to 2 (surface).

Binary files contain two records. The first record contains the number of nodes, the number of 
triangles, and the number of tetrahedra, and the second record contains all of the remaining 
data.

5.1.2.3. Multi-Zone Formats. PLOT3D’s multi-zone formats are the same as the single-
zone formats above, except that one additional integer is added at the beginning of the file 
which specifies the number of zones contained in the file. In binary files, this integer is con-
tained in a separate record.

5.2. Mesh Conversion

Mesh Generator allows you to convert all output mesh zones to a single unstructured zone, 
either triangular or quadrilateral. These options are available in the Mesh Conversion area of 
the Mesh Output dialog. With either of these options, all output mesh zones are converted to 
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the desired type and combined into a single zone, and redundant nodes and cell edges are elim-
inated. This process is illustrated in Figure 5-2.

Redundant nodes and cell edges are identified using the same logic as is used for identifying 
inter-mesh zone connections. Each boundary line identified as an inter-mesh connection will 
result in only a single set of nodes and cell edges, instead of two sets (one for each mesh zone).

Note: The PLOT3D mesh file format does not support quadrilateral unstructured meshes.

5.2.1. Conversion to a Single Quadrilateral Zone

Specifying conversion to a single quadrilateral mesh will result in a mesh whose cells are iden-
tical in appearance to the cells of each individual mesh being converted. In other words, cells 
of triangular unstructured meshes will be output as quadrilaterals with one collapsed face, and 
cells of structured meshes will be output as equivalent quadrilateral cells.

Using this conversion option, it is possible to generate meshes for analysis software which 
requires quadrilateral unstructured meshes. Quadrilateral cells may be created as an arbitrary 
number of structured meshes, and then output using this option.

As noted above, all internal boundaries which represent connections between the original 
meshes are eliminated in the converted mesh. If the mesh is output to a Tecplot mesh file, the 
boundary regions corresponding to the remaining boundaries are included in the mesh file to 
enable analysis software to identify cell edges which lie on the boundaries of the mesh.

Figure 5-2. A converted mesh.



5.2. Mesh Conversion
5.2.2. Conversion to a Single Triangular Zone

Specifying conversion to a single triangular mesh will result in each mesh cell of the original 
meshes being output as one or two triangular cells. To triangulate structured meshes, the cells 
are divided by the shorter of the two cell diagonals.

This conversion option is useful for boundary layer flow solutions, or other singular perturba-
tion problems where high aspect ratio cells are required. A good triangular boundary layer 
mesh can be generated by producing a structured mesh in the boundary layer region, and then 
converting the mesh to triangular upon output.

As with the quadrilateral conversion option, internal boundaries between converted meshes are 
eliminated, and lines lying on the boundary of the resulting triangular mesh are included as 
boundary regions in Tecplot mesh files.
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The ADDONCOMMAND Tecplot Macro
CHAPTER 6 Extended Macros

Macro files allow you to automate Tecplot. Mesh Generator augments Tecplot’s macro com-
mand language to allow you to access all of its features from within Tecplot macro files. This 
chapter introduces these macro additions, and presents some examples. Please refer to the 
Tecplot User’s Manual and Reference Manual for a complete description of Tecplot’s macro 
language.

To create a macro, you may have Tecplot record your keystrokes, or use a text editor to 
create a text file containing the macro commands. After you have created the macro, you 
may play it using the Play option, listed under Macro on Tecplot’s File menu, or you may 
invoke it from the command line when you launch Tecplot using the -p option.

6.1. The ADDONCOMMAND Tecplot Macro

All of Mesh Generator’s macro commands are embedded within Tecplot’s ADDONCOMMAND 
macro. The syntax of this macro is shown below:

$!ADDONCOMMAND 
ADDONID = <string> 
COMMAND = <string> 
[RAWDATA 
<string> 
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<string> 
. 
. 
. ]

The first <string> is a text string identifying the Tecplot add-on which should receive the 
command. For Mesh Generator this should be set to “Mesh Generator.” The second string is 
sent to the add-on, and contains all information the add-on needs to process the command. 
The square brackets around RAWDATA indicate that a RAWDATA section may be included 
with ADDONCOMMANDS. Some of Mesh Generator’s macros make use of this feature.

6.2. Macro Command Summary

Mesh Generator has 16 macro commands which may be embedded in the ADDONCOMMAND 
macro as noted above. These are:

• CREATEPOLYLINE: Creates a new boundary line from a set of points.

• CREATECIRCULARARC: Creates a new boundary line along a circular arc.

• CREATECONICARC: Creates a new boundary line along a conic arc.

• EXTRACTLINE: Copies points from an existing boundary line or mesh zone to form a 
new line.

• CREATELINESFROMNURBFILE: Reads an IGES file and creates boundary lines from 
any NURB curves it finds in the file.

• EDITLINEFROMNURBCURVE: Allows the node distribution options to be set for a 
NURB curve.

• READNURBFILE: Used in mesh project files to restore NURB curve-based lines.

• CREATEDEFAULTLINEFROMNURB: Used in mesh project files to restore NURB 
curve-based lines.

• CREATEELLIPTICSURFACE: Creates a mesh zone using an algebraic or elliptic 
method, where all four boundaries of the zone must be specified.

• CREATEHYPERBOLICSURFACE: Creates a mesh zone using a hyperbolic method 
where only the J=1 boundary must be specified.

• CREATEUNSTRUCTUREDSURFACE: Fills a region with triangular cells.

• REMOVELAYER: Removes the J=JMax mesh line from a hyperbolic mesh zone, reduc-
ing the J-dimension by one.
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• DELETEZONE: Deletes an existing boundary line or mesh zone if your other zones are 
not dependent on it.

• READPROJECTFILE: Restores the mesh generation project.

• WRITEPROJECTFILE: Saves the current mesh generation project.

• WRITEGRIDFILE: Creates a mesh file containing the specified mesh zones.

6.3. Macro Commands

The syntax and parameters for each of Mesh Generator’s macro commands are listed below. 
Items within single angle brackets (< >’s) are defined in 6.4., “Parameter Assignment Val-
ues” on page 94.

Note: The COMMAND strings below must be contained on a single line in your macro 
command file, although they appear on multiple lines below.

CREATEPOLYLINE

Syntax: $!ADDONCOMMAND 
ADDONID = ’Mesh Generator’ 
COMMAND=’CREATEPOLYLINE 

[optional parameters]’ 
RAWDATA 
<polylinerawdata>

Description: Create a new mesh line based on a set of control points (a polyline). The 
control points define the path along which mesh nodes are distributed. 
These control points must be specified in the RAWDATA section. See 6.5., 
“Raw Data” on page 95 for a description of <polylinerawdata>.

Optional Parameters:

Parameter Syntax Default Notes
REPLACEZONE = <integer> 0 Zone to replace with the generated line. If 0, a 

new line is created.

LABEL = <string> ““ The zone title to apply to the created line.
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Example 1: Add a five-node polyline with default distribution (control points):

$!ADDONCOMMAND 
ADDONID = ’Mesh Generator’ 
COMMAND = ‘CREATEPOLYLINE’ 

RAWDATA 
1 
5 
0.0 0.0 
1.0 1.0 
2.0 4.0 
3.0 9.0 
4.0 16.0 

Example 2: Add a 25-node polyline with five control points, and 

INDEXSTART = <integer> 1 The control point index at which to begin distrib-
uting mesh nodes.

INDEXEND = <integer> 0 The control point index at which to cease distrib-
uting mesh nodes; 0 indicates the final control 
point.

DISTRIBUTION
= <distributionoption>

ASIS The method used to distribute points along the 
path defined by the control points. ASIS uses the 
control points themselves. If MULTIPLETANH, 
then the RAWDATA section must contain cluster-
ing data.

NUMBEROFNODES = <integer> (number of 
control 
points)

The number of mesh nodes to distribute along the 
path defined by the control points.

REVERSELINEDIRECTION
= <boolean>

FALSE If set to TRUE, the mesh nodes are distributed in 
the opposite direction of the control points.

TWOSIDED = <boolean> TRUE Not used for ASIS and EVENSPACING distribu-
tion options. If FALSE, only the initial or final 
node spacing is used; set the other to zero. If 
TRUE, both initial and final spacing are set.

INITIALSPACING
= <double>

.001 The initial node spacing.

FINALSPACING = <double> .001 The final node spacing. Used only if TWOSIDED 
is set to TRUE.

INTERPOLATION
= <interpolationoption>

CUBIC The method of interpolating between control 
points for node placement. If CUBIC, then a free 
cubic spline is used.

Parameter Syntax Default Notes
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multiple-tanh distribution with two clustering 

points. Note that the number of nodes between the 
final clustering point and the end of the line is 

calculated from NUMBEROFNODES.

$!ADDONCOMMAND 
ADDONID = ’Mesh Generator’ 
COMMAND = ‘CREATEPOLYLINE 

DISTRIBUTION = MULTIPLETANH 
NUMBEROFNODES = 25’ 
RAWDATA 
3 
5 # Control points 
0.0 0.0 
1.0 1.0 
2.0 4.0 
3.0 9.0 
4.0 16.0 
2 # Clustering locations 
1.0 1.0 
2.5 6.3 
2 # Spacing and # of segment nodes 
.0005 5 
.0005 10

CREATECIRCULARARC

Syntax: $!ADDONCOMMAND 
ADDONID = ’Mesh Generator’ 
COMMAND=’CREATECIRCULARARC 

[optional parameters]’ 
[RAWDATA 
<clusteringrawdata>]

Description: Create a new mesh line whose nodes are distributed along a circular arc. 
If MULTIPLETANH distribution is used, the clustering data must be 
specified in the RAWDATA section. See 6.5., “Raw Data” on page 95 for a 
description of <clusteringrawdata>.
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Optional Parameters:

Parameter Syntax Default Notes
REPLACEZONE = <integer> 0 Zone to replace with the generated line. If 

0, a new line is created.

LABEL = <string> ““ The zone title to apply to the created line.

HOWSPECIFIED 
= <circlespec>

SPECIFYORIGIN Indicates how the circular arc will be 
defined. If SPECIFYORIGIN, set the ori-
gin and starting locations and the arc angle. 
If SPECIFYRADIUS, set the starting and 
ending locations and the radius.

COUNTERCLOCKWISE
= <boolean>

FALSE If TRUE, indicates that the arc proceeds in 
the counter-clockwise direction.

XORIGIN = <double> 0.0 X location of the arc’s origin. Used only if 
HOWSPECIFIED is set to SPECIFYORI-
GIN.

YORIGIN = <double> 0.0 Y location of the arc’s origin. Used only if 
HOWSPECIFIED is set to SPECIFYORI-
GIN.

XSTART = <double> 1.0 X location of the beginning of the arc.

YSTART = <double> 0.0 Y location of the beginning of the arc.

XEND = <double> 0.0 X location of the end of the arc. Used only 
if HOWSPECIFIED is set to SPECIFYRA-
DIUS.

YEND = <double> 1.0 Y location of the end of the arc. Used only 
if HOWSPECIFIED is set to SPECIFYRA-
DIUS.

ARCANGLE = <double> 90.0 The angle of the arc. Used only if HOW-
SPECIFIED is set to SPECIFYORIGIN.

RADIUS = <double> 1.0 The radius of the arc. Used only if HOW-
SPECIFIED is set to SPECIFYRADIUS.

DISTRIBUTION
= <distributionoption>

EVENSPACING The method used to distribute points along 
the path defined by the circular arc. If 
MULTIPLETANH, then the RAWDATA sec-
tion must contain clustering data.

NUMBEROFNODES = <integer> 30 The number of mesh nodes to distribute 
along the circular arc.

REVERSELINEDIRECTION
= <boolean>

FALSE If set to TRUE, the mesh nodes are distrib-
uted in the opposite direction of the arc.
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Example 1: Add a 25-node circular arc with default (even spacing) distribution:

$!ADDONCOMMAND 
ADDONID = ’Mesh Generator’ 
COMMAND = ‘CREATECIRCULARARC 

XORIGIN = 1.0 
YORIGIN = 3.0 
XSTART = 5.0 
YSTART = 3.0 
ARCANGLE = 45.0 
NUMBEROFNODES = 25’ 

Example 2: Add a 50-node counter-clockwise circular arc with multiple hyperbolic 
tangent distribution (three clustering points), specifying the starting and 
ending points and the radius:

$!ADDONCOMMAND 
ADDONID = ’Mesh Generator’ 
COMMAND = ‘CREATECIRCULARARC 

SPECIFYORIGIN = FALSE 
COUNTERCLOCKWISE = TRUE 
XSTART = 5.0 
YSTART = 3.0 
XEND = 3.0 
YEND = 5.0 
RADIUS = 5.5 
DISTRIBUTION = MULTIPLETANH 
NUMBEROFNODES = 50 
INITIALSPACING = .01 
FINALSPACING = .01’ 
RAWDATA 
2 

TWOSIDED = <boolean> TRUE Not used for ASIS and EVENSPACING 
distribution options. If FALSE, only the ini-
tial or final node spacing is used; set the 
other to zero. If TRUE, both initial and final 
spacing are set.

INITIALSPACING
= <double>

.001 The initial node spacing.

FINALSPACING = <double> .001 The final node spacing. Used only if TWO-
SIDED is set to TRUE.

Parameter Syntax Default Notes
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3 
4.5 3.6 
4.0 4.25 
3.5 4.7 
3 
.001 16 
.1 11 
.001 11

CREATECONICARC

Syntax: $!ADDONCOMMAND 
ADDONID = ’Mesh Generator’ 
COMMAND=’CREATECONICARC 

[optional parameters]’ 
[RAWDATA 
<clusteringrawdata>]

Description: Create a new mesh line whose nodes are distributed along a conic arc. If 
MULTIPLETANH distribution is used, the clustering data must be 
specified in the RAWDATA section. See 6.5., “Raw Data” on page 95 for a 
description of <clusteringrawdata>.

Optional Parameters:

Parameter Syntax Default Notes
REPLACEZONE = <integer> 0 Zone to replace with the generated line. If 

0, a new line is created.

LABEL = <string> ““ The zone title to apply to the created line.

XSTART = <double> 1.0 X location of the beginning of the arc.

YSTART = <double> 0.0 Y location of the beginning of the arc.

XEND = <double> 0.0 X location of the end of the arc. 

YEND = <double> 1.0 Y location of the end of the arc. 

XVERTEX = <double> 1.0 X location of the vertex of the arc. 

YVERTEX = <double> 1.0 Y location of the vertex of the arc. 

LENGTHRATIO = <double> 0.5 The ratio of the height of the arc to the 
height of the vertex above the baseline.
80



Macro Commands
Example 1: Add a 25-node parabolic arc (LENGTHRATIO=0.5) with default (even 
spacing) distribution:

$!ADDONCOMMAND 
ADDONID = ’Mesh Generator’ 
COMMAND = ‘CREATECONICARC 

XSTART = 0.0 
YSTART = 0.0 
XEND = 1.0 
YEND = 0.0 
XVERTEX = 0.5 
YVERTEX = 1.0 
LENGTHRATIO = 0.5 
NUMBEROFNODES = 25’ 

Example 2: Add a 50-node hyperbolic (LENGTHRATIO>0.5) arc with multiple 
hyperbolic tangent distribution (one clustering point):

$!ADDONCOMMAND 
ADDONID = ’Mesh Generator’ 
COMMAND = ‘CREATECONICARC 

XSTART = 5.0 
YSTART = 3.0 
XEND = 3.0 

DISTRIBUTION
= <distributionoption>

EVENSPACING The method used to distribute points along 
the path defined by the circular arc. If 
MULTIPLETANH, then the RAWDATA sec-
tion must contain clustering data.

NUMBEROFNODES = <integer> 30 The number of mesh nodes to distribute 
along the circular arc.

REVERSELINEDIRECTION
= <boolean>

FALSE If set to TRUE, the mesh nodes are distrib-
uted in the opposite direction of the arc.

TWOSIDED = <boolean> TRUE Not used for ASIS and EVENSPACING 
distribution options. If FALSE, only the ini-
tial or final node spacing is used; set the 
other to zero. If TRUE, both initial and final 
spacing are set.

INITIALSPACING
= <double>

.001 The initial node spacing.

FINALSPACING = <double> .001 The final node spacing. Used only if TWO-
SIDED is set to TRUE.

Parameter Syntax Default Notes
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YEND = 5.0 
XVERTEX = 4.0 
YVERTEX = 7.0 
LENGTHRATIO = 0.75 
DISTRIBUTION = MULTIPLETANH 
NUMBEROFNODES = 50 
INITIALSPACING = .01 
FINALSPACING = .01’ 
RAWDATA 
2 
1 
4.0 7.0 
1 
.001 26

EXTRACTLINE

Syntax: $!ADDONCOMMAND 
ADDONID = ’Mesh Generator’ 
COMMAND=’EXTRACTLINE 

[optional parameters]’

Description: Create a new mesh line whose nodes are a subset of an existing line or 
surface.

Optional Parameters:

Parameter Syntax Default Notes
REPLACEZONE = <integer> 0 Zone to replace with the extracted line. If 0, 

a new line is created.

LABEL = <string> ““ The zone title to apply to the created line.

SOURCEZONE = <integer> 1 The zone number of the source zone.

BOUNDARYLINE
= <zoneboundary>

IMIN Ignored if the source zone is a line. If the 
source zone is a surface (an IJ-ordered 
zone), this parameter indicates from which 
zone boundary the line is to be extracted.
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Example 1: Extract nodes 2 to IMAX-1 from zone 1 (a line):

$!ADDONCOMMAND 
ADDONID = ’Mesh Generator’ 
COMMAND = ‘EXTRACTLINE 

INDEXSTART = 2 
INDEXEND = -1’ 

Example 2: Extract all nodes from the JMAX boundary of zone 5 (a surface):

$!ADDONCOMMAND 
ADDONID = ’Mesh Generator’ 
COMMAND = ‘EXTRACTLINE 

SOURCEZONE = 5 
BOUNDARYLINE = JMAX’ 

CREATELINESFROMNURBFILE

Syntax: $!ADDONCOMMAND 
ADDONID = ’Mesh Generator’ 
COMMAND=’CREATELINESFROMNURBFILE <string>’

Description: Create mesh lines from IGES-NURB curves in a file. The string must 
contain one file name, which should be a valid IGES-ASCII file.

Example: Create mesh lines from file airfoil.igs:

$!ADDONCOMMAND 
ADDONID = ’Mesh Generator’ 
COMMAND = ‘CREATELINESFROMNURBFILE airfoil.igs’

INDEXSTART = <integer> 1 The source zone index at which to begin the 
extraction.

INDEXEND = <integer> 0 The source zone node index at which to ter-
minate the extraction; 0 indicates the maxi-
mum index value, and negative numbers 
indicate values less than the maximum 
index (e.g. -1 gives IMAX-1).

Parameter Syntax Default Notes
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EDITLINEFROMNURBCURVE

Syntax: $!ADDONCOMMAND 
ADDONID = ’Mesh Generator’ 
COMMAND=’EDITLINEFROMNURBCURVE 

REPLACEZONE = <integer> 
[optional parameters]’ 
[RAWDATA 
<clusteringrawdata>]

Description: Edit an existing mesh line whose nodes are distributed along a NURB 
curve. If MULTIPLETANH distribution is used, the clustering data must 
be specified in the RAWDATA section. See 6.5., “Raw Data” on page 95 
for a description of <clusteringrawdata>.

Required Parameter:

Optional Parameters:

Parameter Syntax Notes
REPLACEZONE = <integer> Zone to replace with the generated line.

Parameter Syntax Default Notes
LABEL = <string> "" The zone title to apply to the line.

DISTRIBUTION
= <distributionoption>

EVENSPACING The method used to distribute points along 
the path defined by the NURB curve. If 
MULTIPLETANH, then the RAWDATA sec-
tion must contain clustering data. The 
ASIS option is not available

NUMBEROFNODES = <integer> 30 The number of mesh nodes to distribute 
along the curve.

REVERSELINEDIRECTION
= <boolean>

FALSE If set to TRUE, the mesh nodes are distrib-
uted in the opposite direction of the curve.

TWOSIDED = <boolean> TRUE Not used for ASIS and EVENSPACING 
distribution options. If FALSE, only the ini-
tial or final node spacing is used; set the 
other to zero. If TRUE, both initial and final 
spacing are set.
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Example 1: Edit a line to give it 25 nodes with default (even spacing) distribution:

$!ADDONCOMMAND 
ADDONID = ’Mesh Generator’ 
COMMAND = ‘EDITLINEFROMNURBCURVE 

REPLACEZONE = 2 
NUMBEROFNODES = 25’ 

Example 2: Edit a line to give it 50 nodes with multiple hyperbolic tangent 
distribution (three clustering points). Reverse the line direction:

$!ADDONCOMMAND 
ADDONID = ’Mesh Generator’ 
COMMAND = ‘EDITLINEFROMNURBCURVE 

REPLACEZONE = 3 
DISTRIBUTION = MULTIPLETANH 
NUMBEROFNODES = 50 
REVERSELINEDIRECTION = TRUE 
INITIALSPACING = .01 
FINALSPACING = .01’ 
RAWDATA 
2 
3 
4.5 3.6 
4.0 4.25 
3.5 4.7 
3 
.001 16 
.1 11 
.001 11

INITIALSPACING
= <double>

.001 The initial node spacing.

FINALSPACING = <double> .001 The final node spacing. Used only if TWO-
SIDED is set to TRUE.

Parameter Syntax Default Notes
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CREATELINESFROMNURBFILE

Syntax: $!ADDONCOMMAND 
ADDONID = ’Mesh Generator’ 
COMMAND=’CREATELINESFROMNURBFILE <string>’

Description: Create mesh lines from IGES-NURB curves in a file. The string must 
contain one file name, which should be a valid IGES-ASCII file.

Example: Create mesh lines from file airfoil.igs:

$!ADDONCOMMAND 
ADDONID = ’Mesh Generator’ 
COMMAND = ‘CREATELINESFROMNURBFILE airfoil.igs’

READNURBFILE

Syntax: $!ADDONCOMMAND 
ADDONID = ’Mesh Generator’ 
COMMAND=’READNURBFILE <string>’

Description: Read an IGES file containing NURB curves. This macro is intended only 
for use by Mesh Generator to write project files. You should not use this 
macro in your macro files.

CREATEDEFAULTLINEFROMNURB

Syntax: $!ADDONCOMMAND 
ADDONID = ’Mesh Generator’ 
COMMAND=’CREATEDEFAULTLINEFROMNURB 

ENTITYNUMBER = <integer> 
[REPLACEZONE = <integer>]’

Description: Read an IGES file containing NURB curves. This macro is intended only 
for use by Mesh Generator to write project files. You should not use this 
macro in your macro files.
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Required Parameter:

Optional Parameter:

CREATEELLIPTICSURFACE

Syntax: $!ADDONCOMMAND 
ADDONID = ’Mesh Generator’ 
COMMAND=’CREATEELLIPTICSURFACE 

[optional parameters]’

Description: Create a new elliptic surface. Where <optional parameters> is composed 
of name-value pairs documented in the below list. The variable name is 
followed by its type in parentheses. If it is an Option parameter (usually 
corresponding to an option menu), the list of acceptable options is on the 
next line. On the final line is its default value. All of the string values 
must be enclosed by escaped apostrophes (\’...\’) within the Command 
string.

Optional Parameters:

Parameter Syntax Notes
ENTITYNUMBER = <integer> NURB entity number, assigned internally (not the IGES ID number).

Parameter Syntax Default Notes
REPLACEZONE = <integer> 0 Zone to replace with the generated line.

Parameter Syntax Default Notes
REPLACEZONE = <integer> 0 Zone to replace with the generated surface. 

If 0, a new surface is created.

LABEL = <string> "" The zone title to apply to the created sur-
face.

IMINBOUNDARY = <list> "1" The numbers of zones that form the I=1 
boundary.

IMAXBOUNDARY = <list> "1" The numbers of zones that form the I=IMax 
boundary.
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Example 1: Create an elliptic surface using the Laplace method with no more than 20 

iterations:

$!ADDONCOMMAND 
ADDONID = ’Mesh Generator’ 
COMMAND = ‘CREATEELLIPTICSURFACE LABEL="Surface 1" 

IMinBoundary="3" 
IMaxBoundary="4" 
JMinBoundary="1" 
JMaxBoundary="2" 
Method=EllipticLaplace 
MaxIterations=20’

CREATEHYPERBOLICSURFACE

Syntax: $!ADDONCOMMAND 
ADDONID = ’Mesh Generator’ 
COMMAND=’CREATEHYPERBOLICSURFACE 

[optional parameters]’

Description: Create a new hyperbolic surface.

JMINBOUNDARY = <list> "1" The numbers of zones that form the J=1 
boundary.

JMAXBOUNDARY = <list> "1" The numbers of zones that form the 
J=JMax boundary.

ORTHORELAXATION
= <double>

0.1 For the elliptic-orthogonal method only, the 
normalized distance (as a percentage of I- 
or J-index) at which the orthogonality con-
straint is relaxed to ten percent of its maxi-
mum.

MAXITERATIONS = <integer> 100 For elliptic methods only, the maximum 
number of relaxation iterations to perform.

RELAXATION
= <double>

1 For elliptic methods only, the relaxation 
factor for the rexation method.

Parameter Syntax Default Notes
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Optional Parameters:

Example 1: Create a hyperbolic surface with periodic constraints (making an “O-
mesh”):

$!ADDONCOMMAND 
ADDONID = ’Mesh Generator’ 
COMMAND = ‘CREATEHYPERBOLICSURFACE 

BOUNDARY = “1,2,3” 
TOTALDISTANCE = 5.0 
IMINCONSTRAINT = PERIODIC 
IMAXCONSTRAINT = PERIODIC’ 

Example 2: Create a hyperbolic surface with X=constant constraints (making a “C-
mesh”):

$!ADDONCOMMAND 

Parameter Syntax Default Notes
REPLACEZONE = <integer> 0 Zone to replace with the generated surface. 

If 0, a new surface is created.

LABEL = <string> ““ The zone title to apply to the created sur-
face.

BOUNDARY = <list> “1” The numbers of the zones which form the 
J=1 boundary.

NUMBEROFLAYERS = <integer> 25 The number of layers of the mesh, includ-
ing the initial boundary (JMax of the gener-
ated surface).

INITIALSPACING = <double> .0001 The normal distance between the initial 
boundary and second layer.

TOTALDISTANCE = <double> 1.0 The approximate normal distance of the 
final layer from the initial boundary.

IMINCONSTRAINT
= <constraint>

NONE The constraint of the I=1 boundary.

IMAXCONSTRAINT
= <constraint>

NONE The constraint of the I=IMax boundary.

MAXLOCALITERS = <integer> 1000 The maximum number of iterations per-
formed to smooth each layer.

COLLISIONDETECTION
= <boolean>

FALSE If TRUE, searches for collisions with other 
surfaces during generation.

REVERSEDIRECTION
= <boolean>

FALSE If TRUE, reverses the marching direction.
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ADDONID = ’Mesh Generator’ 
COMMAND = ‘CREATEHYPERBOLICSURFACE 

BOUNDARY = “1,2” 
TOTALDISTANCE = 5.0 
IMINCONSTRAINT = XCONSTANT 
IMAXCONSTRAINT = XCONSTANT

CREATEUNSTRUCTUREDSURFACE

Syntax: $!ADDONCOMMAND 
ADDONID = ’Mesh Generator’ 
COMMAND=’CREATEUNSTRUCTUREDSURFACE 

[optional parameters]’ 
RAWDATA 
<boundaryrawdata>

Description: Create a new algebraic or elliptic surface. The RAWDATA section must 
contain lists of zone numbers which define one external (counter-
clockwise) boundary, and zero or more internal (clockwise) boundaries. 
See 6.5., “Raw Data” on page 95 for a description of the format of this 
data.

Optional Parameters:

Example: Create an unstructured surface with two boundaries, reversing the 
direction of the second boundary:

$!ADDONCOMMAND 
ADDONID = ’Mesh Generator’ 

Parameter Syntax Default Notes
REPLACEZONE = <integer> 0 Zone to replace with the generated surface. 

If 0, a new surface is created.

LABEL = <string> ““ The zone title to apply to the created sur-
face.

MAXCELLS = <integer> 100000 The maximum number of cells to be used to 
create the surface. Must be greater than the 
number of segments of all boundaries com-
bined.

SMOOTHING = <boolean> FALSE If TRUE, smooths the final mesh.
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COMMAND = ‘CREATEUNSTRUCTUREDSURFACE 
MAXCELLS = 10000’ 
RAWDATA 
2 
1 2 
3 4 5 R

REMOVELAYER

Syntax: $!ADDONCOMMAND 
ADDONID = ’Mesh Generator’ 
COMMAND=’REMOVELAYER <integer>’ 

[no parameters]

Description: Remove the J=JMax line from the indicated zone.

Example: Remove the J=JMax line from zone 3:

$!ADDONCOMMAND 
ADDONID = ’Mesh Generator’ 
COMMAND = ‘REMOVELAYER 3’

DELETEZONE

Syntax: $!ADDONCOMMAND 
ADDONID = ’Mesh Generator’ 
COMMAND=’DELETEZONE <integer>’ 

[no parameters]

Description: Delete the indicated Tecplot zone, unless another zone is dependent on it.

Example: Delete zone 3:

$!ADDONCOMMAND 
ADDONID = ’Mesh Generator’ 
COMMAND = ‘DELETEZONE 3’
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READPROJECTFILE

Syntax: $!ADDONCOMMAND 
ADDONID = ’Mesh Generator’ 
COMMAND=’READPROJECTFILE <string>’ 

[no parameters]

Description: Clear the existing mesh generation project, and read the project file 
indicated by <string>.

Example: Read project file airfoil.lay:

$!ADDONCOMMAND 
ADDONID = ’Mesh Generator’ 
COMMAND = ‘READPROJECTFILE airfoil.lay’

WRITEPROJECTFILE

Syntax: $!ADDONCOMMAND 
ADDONID = ’Mesh Generator’ 
COMMAND=’WRITEPROJECTFILE <string>’ 

[no parameters]

Description: Save the existing mesh generation project to the file indicated by 
<string>.

Example: Write project file airfoil.lay:

$!ADDONCOMMAND 
ADDONID = ’Mesh Generator’ 
COMMAND = ‘WRITEPROJECTFILE airfoil.lay’

WRITEGRIDFILE

Syntax: $!ADDONCOMMAND 
ADDONID = ’Mesh Generator’ 
COMMAND=’WRITEGRIDFILE <string> 

[optional parameters]’
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Description: Write mesh zones to the file specified by <string>.

Optional Parameters:

Example 1: Write mesh file airfoil.dat in Tecplot ASCII format containing 
zones 1, 3, 4, and 5:

$!ADDONCOMMAND 
ADDONID = ’Mesh Generator’ 
COMMAND = ’WRITEGRIDFILE airfoil.dat 

ZONELIST = [1,3-5]’ 

Example 2: Write mesh file airfoil.g in PLOT3D binary format combining zones 
1, 3, 4, and 5 into a single triangular zone:

$!ADDONCOMMAND 
ADDONID = ’Mesh Generator’ 
COMMAND = ’WRITEGRIDFILE airfoil.g 

FORMAT = PLOT3D 
TYPE = BINARY 
CONVERSION = TRIANGULAR 
ZONELIST = [1,3-5]’

Parameter Syntax Default Notes
FORMAT = <gridformatoption> TECPLOT Format in which to write the mesh file.

TYPE = <gridtypeoption> ASCII ASCII or BINARY

CONVERSION
= <conversionoption>

NONE Options to convert all output mesh zones to 
a single triangular or quadrilateral mesh 
zone.

MULTIZONE = <boolean> FALSE Only used when writing a single mesh zone 
to a PLOT3D file. Indicates whether multi-
zone format should be used. If FALSE, the 
single-zone format will be used.

ZONELIST = <set> All zones The Tecplot zones to write to the file.
93



Chapter 6. Extended Macros
6.4. Parameter Assignment Values

Parameter assignments referenced in the previous section using angle brackets (< >’s), and 
not defined in the Tecplot Reference Manual, are defined here. Note that case is not impor-
tant. 

Value Identifier Allowable Values
<distributionoption> ASIS, EVENSPACING, EXPONENTIAL, TANH, 

MULTIPLETANH, POLYNOMIAL

<interpolationoption> CUBIC, LINEAR

<circlespec> SPECIFYORIGIN, SPECIFYRADIUS

<zoneboundary> IMIN, IMAX, JMIN, JMAX

<ellipticmethod> ALGEBRAICARCLENTH, ALGEBRAICLINEAR, 
ALGEBRAICEDGEORTHO, ELLIPTICLAPLACE, 
ELLIPTICTHOMAS, ELLIPTICORTHOGONAL

<list> “<integer>,<integer>...”

<constraint> NONE, XCONSTANT, YCONSTANT, PERIODIC

<gridformatoption> TECPLOT, PLOT3D

<gridtypeoption> ASCII, BINARY

<conversionoption> NONE, TRIANGULAR, QUADRILATERAL
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6.5. Raw Data

Some macro commands contain a “raw data” section. A raw data section is defined by using 
the keyword RAWDATA followed by the raw data values unique to the macro command. 
Most raw data sections start with a single count value which represents the number of blocks 
of raw data followed by the blocks of raw data themselves. The following table lists the raw 
data sections found in Mesh Generator macros.

Raw Data Name
Value Type(s) 
per Block Notes

<polylinerawdata> <xyrawdata> The first block contains the locations of the control 
points. If MULTIPLETANH distribution is used, two 
more blocks must follow the first. The second block 
contains the clustering points. The X-values of the 
final block contain the spacing for each point, and 
the Y-values contain the number of nodes to be 
placed in the preceding segment (an integer value).

<clusteringrawdata> <xyrawdata> This must consist of two blocks. The first block con-
tains the clustering points. The X-values of the final 
block contain the spacing for each point, and the Y-
values contain the number of nodes to be placed in 
the preceding segment (an integer value).

<boundaryrawdata> <integer>
<integer>
...
[R]

This is a list of integers (zone numbers) followed by 
an optional R. The direction of the boundary is taken 
from the first zone in the list. The R, if present, indi-
cates that this node order is to be reversed.
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CHAPTER 7 Examples

This chapter details four more advanced examples of meshes you can create in Mesh Genera-
tor. The first is a two-dimensional flat plate with flow over a circular leading edge, which 
explores geometry and structured mesh creation, mesh control methods such as Algebraic-
Arclength and Elliptic-Thomas, mesh smoothing, the use of two polylines as a boundary, and 
Mesh Generator’s various node distributions methods such as tanh, even and exponential spac-
ing. 

The remaining three examples are based on a three-element airfoil. The first three-element 
airfoil example demonstrates how to use Hyperbolic Structured mesh generation. The last 
three-element airfoil examples use hybrid meshes. They use hyperbolic meshes to resolve the 
boundary layer and mixing regions. Then the computational domains are linked together with 
an unstructured mesh.

7.1. Two-Dimensional Flat Plate Example with a 
Structured Mesh

An overview of the flat plate example is shown in Figure 7-1. To create your flat plate, perform 
the following steps. 

7.1.1. Creating the Boundary

First, we will create the circular leading edge, which will be the first section of the IMin 
boundary.

1. Select Create Circular Arc from the Boundary menu. On the Circular Arc dialog set Spec-
ify to Center, Starting Point, Arc Angle. 

2. Enter the following values into the Center, Start and Arc Angle text fields. For Center, use 0 
for X and 0 for Y. For Start use -5.0e-5 for X and 0 for Y. For Arc Angle use 90. 
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3. Click Node Distribution. On the Node Distribution dialog set Distribution to Exponential, 
Number of Nodes to 9, and select One-Sided (Initial). Set Initial Spacing to 8e-6, and Inter-
polation to Cubic. Click OK.

4. On the Circular Arc dialog, use the Line Label text field to name this boundary “imin1,” 
then click Create. Close the dialog.

We will now create the upper surface of the flat plate, the second section of the IMin boundary. 
On the Tecplot sidebar, verify that the scatter plot layer option is active. If it is not already 
active, click on the check box, then click Redraw.

1. With the Tecplot Selector tool, click on the end node, or a node near the end, of imin1, the 
circular leading edge boundary. From the Boundary menu, select Create Polyline, this will 
call up the Polyline dialog. 

2. On the Polyline dialog, click Select Endpt.; this will enter the values of the imin1 end point 
into the X- and Y-fields. Now click Insert Before, which will enter the values into the Con-
trol Points list. Now manually enter the X- and Y-coordinates for the end points of the 
upper surface boundary, using 9.5e-5 for X and 5e-5 for Y. Click Insert After. 

Figure 7-1. An overview of the flat plate example.
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3. Click Node Distribution. On the Node Distribution dialog, set Distribution to Tanh, Num-
ber of Nodes to 8, Initial Spacing to 1.13e-5, Final Spacing to 1.6e-5. Click OK.

4. On the Polyline dialog, use the Line Label text field to name this boundary “imin2,” then 
click Create.

We will now create the downstream, or JMax boundary. 

1. First, click on the end node, or a node near the end of imin2, the upper surface boundary, 
with the Tecplot Selector tool. 

2. On the Polyline dialog, click Select Endpt. to enter the X- and Y-values into the text fields, 
then click Insert Before to add the values to the Control Points list. Now manually enter the 
X- and Y-coordinates for the end points of the downstream boundary, using 9.5e-5 for X 
and 2.0225e-4 for Y. Click Insert After. 

3. Click Node Distribution on the Polyline dialog. On the Node Distribution dialog, set Distri-
bution to Exponential, Number of Nodes to 23, Spacing to Two-Sided, Initial Spacing to 
1e-7, Final Spacing to 1e-5. Click OK.

4. On the Polyline dialog, use the Line Label text field to name this boundary “jmax1,” then 
click Create. Close the dialog.

We will now create the first section of the farfield, or IMax boundary. 

1. From the Boundary menu, select Create Circular Arc. On the Circular Arc dialog, set Spec-
ify to Center, Starting Point, Arc Angle, Center to 1.1e-4 for X and 1.6e-6 for Y, Start to -
7.5e-5 for X and 0 for Y, and Arc Angle to 51.

2. Click Node Distribution. On the Node Distribution dialog, set Distribution to Exponential, 
Number of Nodes to 11, Spacing to Two-Sided, Initial Spacing to 1.3e-5, Final Spacing to 
2.0e-5. Click OK.

3. On the Circular Arc dialog, use the Line Label text field to name this boundary “imax1,” 
then click Create.

Now we will create the second section of the farfield, or IMax boundary. 

1. First, click on the end node, or a node near the end of imax1 with the Tecplot Selector tool.

2. On the Polyline dialog, click Select Endpt. to enter the X- and Y-values into the text fields, 
then click Insert Before to add the values to the Control Points list. Still using your Tecplot 
Selector tool, click on a node at or near the start point of the downstream boundary, jmax1. 
On the Polyline dialog, click Select Endpt., then click Insert After.

3. Click Node Distribution. On the Node Distribution dialog, set Distribution to Even Spac-
ing, Number of Nodes to 6. Click OK.

4. On the Polyline dialog, use the Line Label text field to name this boundary “imax2,” then 
click Create.
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We will now create the symmetry plane, the JMin boundary. 

1. First, click on the start node, or a node near the start of imin1, the circular leading edge 
boundary, with the Tecplot Selector tool. 

2. On the Polyline dialog, click Select Endpt. to enter the X- and Y-values into the text fields, 
then click Insert Before to add the values to the Control Points list. Still using your Tecplot 
Selector tool, click on a node at or near the start point of imax1, the first segment of the 
farfield boundary. On the Polyline dialog, click Select Endpt., then click Insert After.

3. Click Node Distribution. On the Node Distribution dialog, set Distribution to Exponential, 
Number of Nodes to 23, Spacing to Two-Sided, Initial Spacing to 1e-7, Final Spacing to 1e-
6. Click OK.

4. On the Polyline dialog, use the Line Label text field to name this boundary “jmin1,” then 
click Create. Close the dialog.

7.1.2. Creating an Algebraic Mesh

With our boundary properly defined, we will now create a structured mesh for our flat plate 
example. To create this mesh, perform the following steps:

1. From the Mesh menu, select Create Algebraic/Elliptic Structured. This will call up the 
Algebraic/Elliptic Structured dialog. 

2. In the Boundaries area of the Algebraic/Elliptic Structured dialog you must enter the 
boundary line into the Enter Mesh Boundary Zone Numbers text fields. You may do this by 
entering the values manually, clicking Add From List buttons, or using the Tecplot Selector 
tool in conjunction with Add Selected buttons. (The Add From List buttons will read Add 
Selected when using the Selector tool.) You should define IMin as imin1 and imin2, IMax 
as imax1 and imax2, JMin as jmin1, and JMax as jmax1. 

3. Accept all other default values. When you do not specify a label, Mesh Generator will 
assign a name based on the type of mesh being used and its zone number, for example, 
“Structured surface 7.” Click Create, then close the dialog.

The resulting mesh is shown in Figure 7-2.

After a mesh is created, it should be closely examined, paying special attention to regions 
bounding surfaces, and other areas of interest. For the flat plate example, it is desirable that the 
radial lines of the mesh extend very close to perpendicular from the surface. Close examination 
of the Algebraic-Arclength mesh reveals that this has not been achieved. Thus, we can now 
delete the surface, or edit it.
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7.1. Two-Dimensional Flat Plate Example with a Structured Mesh
7.1.3. Editing to Create an Elliptic Mesh

Editing is very time efficient if the boundaries being used are not modified. We will now edit 
the mesh in our flat plate example. To do this, perform the following steps:

1. First, select the mesh using the Tecplot Selector tool by clicking on a node on the mesh. 
Now choose Edit Selected Mesh from the Mesh menu. This will call up the Algebraic/
Elliptic Structured dialog.

2. On the Algebraic/Elliptic Structured dialog, set Mesh Control Method to Elliptic-Thomas, 
and Maximum Iterations to 200. Accept all other default values and click Replace. The 
Working dialog will appear while the mesh is regenerated.

The resulting mesh is shown in Figure 7-3.

The mesh should be carefully examined again. At the surface, you will see that the radial lines 
now extend nearly perpendicular, and the overall mesh looks smooth without obvious distor-
tions.

Figure 7-2. The Algebraic-Arclength mesh.
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7.2. Three-Element Airfoil Example with a Hyperbolic 
Structured Mesh

For this example, we will use an existing Tecplot file. Load the data file 
$TEC90HOME\examples\meshgen\airfoil.plt. After the file has loaded, switch 
the Tecplot frame mode to 2D, and click on the Scatter on the plot layer buttons. We are now 
ready to begin.

7.2.1. Creating Branch Connectors

The airfoil.plt file is made up of 13 zones, and is shown in Figure 7-4.

Zones one through four define the slat, and zones five through ten define the wing. Zones 11 
through 13 are the flap. Hyperbolic mesh generation requires that all zones defining the bound-
ary be connected. In addition, when periodic constraints are specified, there is an additional 

Figure 7-3. The Elliptic-Thomas mesh.
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7.2. Three-Element Airfoil Example with a Hyperbolic Structured Mesh
requirement that the zones form a closed-loop. For our airfoil example, the slat and flap are 
connected to the wing with lines called branch connectors.

Now we will add the branch connector from the end point of zone 4 to the starting point of 
zone 10. To do this, perform the following steps:

1. Using the Tecplot Selector tool, select a node near the trailing edge of zone 4. (To make vis-
ibility clearer and selection easier, first use the Tecplot zoom tool to zoom in on the area of 
interest.) Now select Create Polyline from the Boundary menu; this will call up the Polyline 
dialog.

2. On the Polyline Dialog, click Select Endpt. This will enter the value for the ending node of 
the zone 4 boundary to the X- and Y-text fields. Click Insert Before. This will add the val-
ues to the Control Points list. Using the Selector tool again, click on a node on the leading 
edge of zone 10. Go back to the Polyline dialog and click Select Endpt., then Insert Before. 
The values will move to the top of the list.

Figure 7-4. An overview of airfoil.plt.
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3. Click Node Distribution. On the Node Distribution dialog set Distribution to Exponential, 
Number of Nodes to 15, Spacing to Two-Sided, Initial and Final Spacing to 5.0e-4, and 
accept all other default values. Click OK.

4. On the Polyline dialog, use the Line Label text field to name this boundary “bc1,” then 
click Create. Close the dialog.

Now we will add the branch connector from zone 10 to zone 13. Perform the following steps:

1. Using the Tecplot Selector tool, select a node near the trailing edge of zone 10. Now select 
Create Polyline from the Boundary menu; this will call up the Polyline dialog.

2. On the Polyline Dialog, click Select Endpt. This will enter the value for the ending node of 
the zone 10 boundary to the X- and Y-text fields. Click Insert Before. This will add the val-
ues to the Control Points list. Using the Selector tool again, click on a node on the leading 
edge of zone 13. Go back to the Polyline dialog and click Select Endpt., then Insert Before. 
The values will move to the top of the list.

3. Click Node Distribution. On the Node Distribution dialog set Distribution to Exponential, 
Number of Nodes to 13, Spacing to Two-Sided, Initial and Final Spacing to 5.0e-4, and 
accept all other default values. Click OK.

4. On the Polyline dialog, use the Line Label text field to name this boundary “bc2,” then 
click Create. Close the dialog.

7.2.2. Creating a Hyperbolic Mesh

We will now create the mesh for our example. To do this, perform the following steps:

1. From the Mesh Generator menu select Create Hyperbolic Structured. This will call up the 
Hyperbolic Structured dialog.

2. We will be using the zone numbers of the slat, wing, and flap, as well as the two newly cre-
ated branch connectors, as our JMin boundary. You may enter these values either by typing 
them in manually, clicking the Add From List buttons, or using the Tecplot Selector tool in 
conjunction with the Add Selected buttons. (Add From List will read Add Selected when 
using the Selector tool.) You should enter the values in clockwise order, starting at the 
lower edge of the flap, the beginning of zone 11. The order of all the zones, as entered 
clockwise, is 11, 12, 15, 5, 6, 7, 8, 9, 14, 1, 2, 3, 4, 14, 10, 15, and 13. See Figure 7-5 for 
details.

The sharp corners where bc1 connects to the slat, and bc2 connects to the wing, are indica-
tors that the maximum number of smoothing steps need to be increased. To reduce the com-
putational time, an initial, simpler mesh can be generated and repeatedly edited until an 
acceptable smoothing factor is determined.
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7.2. Three-Element Airfoil Example with a Hyperbolic Structured Mesh
3. In the Mesh Control area of the Hyperbolic Structured dialog, set # Layers (JMax) to 10, 
Total Distance to 0.1, Constraints to Periodic (setting the IMin or IMax drop-down to Peri-
odic will automatically set the other to Periodic), and Max. Smoothing Passes to 1000. 
Accept all other default values, then use the Line Label text field to name this boundary 
“mesh1.” Click Create. The Working dialog will appear while the mesh is generated.

7.2.3. Editing the Hyperbolic Mesh

After a mesh is created, it should be closely examined. Each mesh cell should be distinct, and 
no mesh folding or overlapping should be present. Close inspection of the outermost row of 
cells in the region below bc1 reveals that these cells are overlapping. In this case the mesh 
should be modified before proceeding.

To edit the mesh, perform the following steps:

1. First, select the mesh using the Tecplot Selector tool by clicking on a node on the mesh. 
Now choose Edit Selected Mesh from the Mesh menu. This will call up the Hyperbolic 
Structured dialog.

2. On the Hyperbolic Structured dialog, set # Layers (JMax) to 50, Total Distance to 1, and 
Max. Smoothing Passes to 10000. Accept all other default values and click Replace. The 
Working dialog will appear while the mesh is regenerated.

Figure 7-5. Clockwise entry of zone numbers beginning at 
the lower edge of the flap.
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The resulting changes are shown in Figure 7-6.

Note: The time required to regenerate will vary greatly depending upon the speed of the com-
puter.

7.3. Three-Element Airfoil Example with a Hybrid Mesh

For this example, load the data file $TEC90HOME/examples/meshgen/airfoil.plt. 
After the file has loaded, switch the Tecplot frame mode to 2D, and click Scatter on the plot 
layer buttons. We are now ready to begin.

7.3.1. Creating Element Extensions

Element extensions are lines which are added to the trailing edge of each element, in this case, 
our slat, wing, and flap. They allow your meshes to be extended aft of the surface, with the 
intent of resolving the mixing regions at the trailing edge of the elements. They must be created 
in the anticipated direction of the streamlines in this region. To create them, perform the fol-
lowing steps: 

Figure 7-6. The modified Hyperbolic Structured mesh.
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7.3. Three-Element Airfoil Example with a Hybrid Mesh
1. From the Tecplot sidebar, click on the polyline geometry tool. Use it to draw a horizontal 
polyline, about 0.06 units long, anywhere in your current Tecplot frame.

2. Use the Tecplot Selector tool to move the starting point of your new polyline to a point near 
the trailing edge of the slat.

3. Use the adjustor tool to select the down stream end point of your polyline. While trying to 
maintain the polyline’s length, rotate the down stream end to approximate the angle of the 
trailing edge.

4. Now call up the Polyline dialog by selecting Create Polylines from the Boundary menu.

5. Use Tecplot’s Selector tool to select your polyline, then click Convert Polyline Geometry 
Insert After on the Polyline dialog. This will add the values of your polyline to the Control 
Points list on the Polyline dialog.

6. Now click on the starting point values shown for your polyline in the Control Points list. 
Once highlighted, click Delete.

7. In the current Tecplot frame, click on a node at or near the end of the trailing edge of the 
slat. Once selected, go back to the Polyline dialog and click Select Endpt. The values for 
the node at the end of the trailing edge of the slat will be entered into the X- and Y-text 
fields on the Polyline dialog. Click Insert After. The values will be added to the Control 
Points list and will be labeled Control Point 2.

8. Click Node Distribution. On the Node Distribution dialog, set Distribution to Tanh, Num-
ber Of Nodes to 21, Initial Spacing to 0.008 and Final Spacing to 0.0005. Accept all other 
default values and click OK.

9. On the Polyline dialog, use the Line Label text field to name this “line1,” then click Create.

Repeat the process described above to create an element extension from the trailing edge of the 
wing, and from the trailing edge of the flap, using the same settings on the Node Distribution 
dialog and labeling them “line2,” and “line3” respectively.

7.3.2. Creating the Hyperbolic Meshes

We will now create the hyperbolic mesh for our example. To do this, perform the following 
steps:

1. From the Mesh Generator menu, select Create Hyperbolic Structured on the Mesh menu. 
This will call up the Hyperbolic Structured dialog.

2. We will be using the zone numbers of the slat, as well as its newly created extension, as our 
JMin boundary. You may enter these values either by typing them in manually, clicking the 
Add From List buttons, or using the Tecplot Selector tool in conjunction with the Add 
Selected buttons. (Add From List will read Add Selected when using the Selector tool.) 
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You should enter the zones in clockwise order, starting at the trailing edge of the flap, the 
beginning of zone 14. The order of all the zones, as entered clockwise, is 14, 1, 2, 3, 4, and 
14.

3. In the Mesh Control area of the Hyperbolic Structured dialog, set Total Distance to 0.006. 
Accept all other default values, then use the Mesh Label text field to name this boundary 
“m1.” Click Create. The Working dialog will appear while the mesh is generated.

Repeat the process described above to create meshes for the wing and flap. Create “m2” for 
the wing by entering zones 15, 5, 6, 7, 8, 9, 10 and 15 for your JMin boundary, in that order. 
Create “m3” for the flap using zones 16, 11, 12, 13, and 16 for your JMin boundary, in that 
order.

7.3.3. Extracting to Create Internal Boundaries

The outermost boundary (JMax) of each of the hyperbolic meshes you have created will be 
used as the internal boundaries for the unstructured portion of our hybrid mesh. These outer 
boundaries need to be explicitly defined. This is done by creating boundaries from each of the 
hyperbolic meshes. To create these boundaries, perform the following steps:

1. With the Tecplot Selector tool, select mesh1. Now select Extract From Selected Mesh from 
the Boundary menu. This calls up the Extract Selected Mesh dialog.

2. Accept the default boundary line, IMin. In the Line Definition area of the Extract Selected 
Mesh dialog the Start and End text fields refer to the J-range. Set Start to 1 and End to mx 
to specify the complete boundary. Use the Line Label text field to name this boundary 
“sb1,” then click OK.

3. With the Tecplot Selector tool, select mesh1 again. Now select Extract From Selected Mesh 
from the Boundary menu to call up the Extract Selected Mesh dialog again.

4. In the Line Definition area of the Extract Selected Mesh set Boundary Line to JMax. The 
Start and End text fields now refer to the I-range. Set Start to 1 and End to mx. Use the Line 
Label text field to name this boundary “sb2,” then click OK.

5. With the Tecplot Selector tool, select mesh1 a third time. Now select Extract From Selected 
Mesh from the Boundary menu to call up the Extract Selected Mesh dialog again.

6. Set Boundary Line to IMax, and set Start and End to 1 and mx. Use the Line Label text 
field to name this boundary “sb3,” and click OK.

Repeat this process for mesh2 of the wing (wb1, and so forth) and mesh3 of the flap (fb1, and 
so on).
8



7.3. Three-Element Airfoil Example with a Hybrid Mesh
7.3.4. Creating a Circular Outer Boundary

The ideal outer boundary varies depending on flight conditions. A circular boundary that 
extends approximately six chord lengths outward is useful for illustrating how to link the struc-
tured mesh components into one computational domain. To do this, perform the following 
steps:

1. Select Create Circular Arc from the Boundary menu. This will call up the Circular Arc dia-
log.

2. On the Circular Arc dialog set Specify to Center, Starting Point, Arc Angle. Set Center to 
0.7 for X and 0 for Y. Set Start to 0.7 for X and 6 for Y. Set Arc Angle to 360.

3. Click Node Distribution. On the Node Distribution dialog set Distribution to Even Spacing, 
Number Of Nodes to 100, and Interpolation to Cubic. Click OK.

4. On the Circular Arc dialog use the Line Label text field to name this boundary “arc1.” 
Click Create. 

You may want to click on Data Fit from the View menu on the Tecplot menu bar. This will 
resize the elements in the current Tecplot frame so you can see the new boundary in relation to 
the slat, wing and flap.

7.3.5. Creating the Unstructured Mesh

Now we are ready to create the unstructured mesh. To create this mesh, perform the following 
steps:

1. Select Create Unstructured from the Mesh menu. Unstructured mesh boundaries must be 
entered as closed-loops. For this example there will be a total of four closed-loop bound-
aries. This means there will be four entries in the Closed Loop Boundary list.

2. On the Unstructured dialog, click New Boundary. This will enter (Incomplete) into the 
Closed Loop Boundary list. Now click Add From List. In the list presented highlight sb1, 
sb2, and sb3, the boundaries on the slat, then click OK. In the Closed-Loop Boundaries list, 
(Incomplete) will have changed to (Int-Boundary) followed by the three zone numbers of 
the boundaries.

3. Click New Boundary, and repeat the process, adding wb1, wb2, and wb3, the outer bound-
aries on the wing, to your new boundary. Repeat the process once more for the outer bound-
aries on the flap; fb1, fb2, and fb3.

4. Click New Boundary, and this time, use Add From List to add zone 29, arc1. Once it has 
been added, highlight this in the Closed-Loop Boundaries list, and click Reverse Direction 
-- notice that (Int-Boundary) changes to (Ext-Boundary).
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5. Accept all other defaults, if desired, add an appropriate label, then click Create. The Work-
ing dialog will appear while the mesh is generated.

The resulting mesh is shown in Figure 7-7.

7.3.6. Editing the Unstructured Mesh

Unstructured mesh creation in Mesh Generator uses an internal mesh optimization scheme. If 
the optimal mesh is reached before the value you have set for Maximum # Cells is reached, you 
will get a message stating that the optimal unstructured mesh has been created; it will list the 
number of cells used. If the mesh has not met the internal optimization requirement within the 
specified number of cells, you will get a message stating the optimal structured mesh requires 
more than the Maximum # Cells specified. You can either accept the mesh as generated, or edit 
it.

To edit it, perform the following steps:

1. Select the mesh by clicking on a node using the Tecplot Selector tool. Then choose Edit 
Selected Mesh from the Mesh menu.

Figure 7-7. The Unstructured mesh, showing the area 
around the airfoils.
0



7.4. Three-Element Airfoil Example with a Modified C-Mesh
2. For our example the optimization factor is met with a Maximum # Cells value of 40000. On 
the Unstructured dialog, set Maximum # Cells to 40000, then click Replace. The Working 
dialog will appear while the mesh is regenerated.

Note: On some slower systems this mesh may take up to 30 minutes to generate the optimal 
mesh. Increasing Maximum # Cells to 15000 is sufficient to demonstrate how the edit and 
replace features work.

7.4. Three-Element Airfoil Example with a Modified C-
Mesh

In the previous example the optimal mesh resulted in thousands of very small triangular cells 
clustered around the downstream ends of the extensions to the slat, wing and flap. These cells 
are the result of the mesh stretching, which is necessary in the initial mixing layer, but not as 
the flow mixes out downstream. Ideally, we want the mesh on the extensions to be less 
stretched as we move downstream. This will result in fewer triangular cells in a region where 
they are unnecessary. We will accomplish this by using the hyperbolic method in a unique way. 
To start the process we need to switch the frame mode to 2D. Then load the airfoil.plt 
file again, using Tecplot’s Load Data File(s) option.

7.4.1. Creating the Hyperbolic Meshes

We will create a hyperbolic mesh around each element, in this case, the slat, wing, and flap. We 
will then extract the JMin and JMax boundaries from each mesh we have created.

1. Select Create Hyperbolic Structured from the Mesh menu. 

2. We will be using the zone numbers of the slat as our JMin boundary. You may enter these 
values either by typing them in manually, clicking the Add From List buttons, or using the 
Tecplot Selector tool in conjunction with the Add Selected buttons. (Add From List will 
read Add Selected when using the Selector tool.) You should enter the values in clockwise, 
starting at the lower edge of the flap, the beginning of zone 1. The order of all the zones, as 
entered clockwise, is 1, 2, 3, and 4.

3. In the Mesh Control area of the Hyperbolic Structured dialog, set Total Distance to 0.006. 
Accept all other default values, then use the Mesh Label text field to name this boundary 
“s1.” Click Create. The Working dialog will appear while the mesh is generated.

4. Now use the Enter Mesh Boundary Zone Numbers text field to enter the zones of the wing 
as the JMin boundary. Entered clockwise, these should be 5, 6, 7, 8, 9, and 10.
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5. In Mesh Control set Total Distance to 0.006. Accept all other default values, then use the 
Mesh Label text field to name this boundary “w1.” Click Create. The Working dialog will 
appear while your second mesh is generated.

6. Now enter the zones of the flap as your JMin boundary. Entered clockwise, these should be 
11, 12 and 13.

7. In the Mesh Control area set Total Distance to 0.006. Accept all other default values, then 
use the Mesh Label text field to name this boundary “f1.” Click Create. The Working dialog 
will appear while your third mesh is generated. Close the Hyperbolic Structured dialog.

7.4.2. Extracting the Downstream Boundaries

The downstream edges of each of the hyperbolic meshes you have created will be used to form 
the JMin boundaries for the hyperbolic mesh extensions to each airfoil element. For reference, 
see Figure 7-8, which gives an overview of the hyperbolic meshes and their extracted boundary 
lines. 

These outer boundaries need to be explicitly defined. This is done by creating two sub-zones 
from each of the hyperbolic meshes. To create these sub-zones, perform the following steps:

Figure 7-8. An overview of the hyperbolic meshes and their 
extracted boundary lines.
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7.4. Three-Element Airfoil Example with a Modified C-Mesh
1. With the Tecplot Selector tool, select s1. Now select Extract From Selected Mesh from the 
Boundary menu. This calls up the Extract Selected Mesh dialog.

2. In the Line Definition area of the Extract Selected Mesh dialog set Boundary Line to IMax 
Line. Set Start to mx and End to 1. By starting at Mx and ending at 1 we are in effect revers-
ing the line direction. Use the Line Label text field to name this boundary “smax,” then 
click OK. The Warning dialog will appear; click OK.

3. With the Tecplot Selector tool, select s1 again. Now select Extract From Selected Mesh 
from the Boundary menu. This will call up the Extract Selected Mesh dialog again.

4. On the Extract Selected Mesh dialog accept all default values, and use the Line Label text 
field to name this boundary “smin.” Click OK.

Repeat the process creating “wmax” and “wmin” for w1 of the wing and “fmax” and 
“fmin” for f1 of the flap.

7.4.3. Creating the Mixing Region Meshes

We will now use our extractions to form the JMin boundary of three additional hyperbolic 
meshes used to capture the mixing regions of the airfoil elements. To create these meshes, per-
form the following steps:

1. On the Mesh Generator main dialog, click on the Hide 2D Mesh check box, then Redraw. 
With the Selector tool, choose zone 1, e1_1. (You may want to refer to Figure 7-4, “An 
overview of airfoil.plt,” to see how the boundaries of the airfoil are named.) From 
the Boundary menu, choose Selected Line Info. Note the IMin spacing is 0.0005. This is 
the distance between the first and second node of e1_1. This will be used as the initial cell 
spacing requirement when the trailing edge hyperbolic mesh is created. Check and note the 
IMin spacings of e2_1 and e3_1. Now click Hide 2D Mesh again to deactivate it, then 
redraw. Your hyperbolic surfaces should be visible.

2. Use Add From List on the Hyperbolic Structured dialog to enter smax and smin as the JMin 
boundary.

Create “w2” for the wing by repeating these steps, then perform the following steps to cre-
ate “f2” for the flap.

3. Use Add From List on the Hyperbolic Structured dialog to enter fmax and fmin as the JMin 
boundary for the flap.

4. In the Mesh Control area, set # Layers (JMax) to 15, Initial Spacing to 0.00054, Total Dis-
tance to 0.02, and Max. Smoothing Passes to 25.

5. On the Hyperbolic Structured dialog accept all other default values, and use the Mesh Label 
text field to name this mesh “f2.” Click OK. After it has been created, close the Hyperbolic 
Structured dialog.
113



Chapter 7. Examples

11
7.4.4. Extractng to Create Internal Boundaries

The IMin, IMax, and JMax lines of our mixing area boundaries (s2, w2, and f2) will now be 
extracted and combined with the JMax lines of the hyperbolic meshes around each element (f1, 
w1, and f1 on the slat, wing, and flap) to form internal boundaries for the unstructured mesh. 
To create these boundaries, perform the following steps:

1. Using the Tecplot Selector tool, select s2 in your current Tecplot frame. Under the Bound-
ary menu, choose Extract From Selected Mesh. This will call up the Extract Selected Mesh 
dialog. On the Extract Selected Mesh dialog accept all default values and use the Line 
Label text field to name this “sa.” Click OK.

2. Using the Tecplot Selector tool, select s2 again. On the Extract Selected Mesh dialog, set 
Boundary Line to JMax Line. Accept all other default values, then use the Line Label text 
field to name this “sb.” Click OK.

3. Select s2 again. On the Extract Selected Mesh dialog, set Boundary Line to IMax Line. 
Accept all other default values, then use the Line Label text field to name this “sc.” Click 
OK.

4. Select s1. On the Extract Selected Mesh dialog, set Boundary Line to JMax Line. Accept 
all other default values, then use the Line Label text field to name this “sd.” Click OK.

These four exterior lines will form one closed-loop interior boundary when you created 
your unstructured mesh. Repeat this process for the w1 and w2 on the wing. Repeat it a 
third time for f1 and f2 on the flap.

7.4.5. Creating the Circular Outer Boundary

We will now create the outer boundary for the unstructured mesh. To do this, perform the fol-
lowing steps:

1. Select the Tecplot circle tool and click Tool Details on the Tecplot sidebar. In the Geometry 
dialog, set the Origin X and Y value to 0. Also set the Circle Radius to 6. Click Place and 
close the dialog. 

2. To view the circle geometry, select Fit to Full Size under the View menu on the Tecplot 
menu bar.

3. On the Boundary menu select Create Circular Arc. This will call up the Circular Arc dialog.

4. With the Selector tool click on the circle geometry. On the Circular Arc dialog, click Con-
vert Circle Geometry. This will enter the values of your circle into the text fields in the Arc 
area of the dialog.

5. Now click Node Distribution. On the Node Distribution dialog, set Distribution to Even 
Spacing and Number Of Node to 40. Accept all other default values, then click OK.
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7.4. Three-Element Airfoil Example with a Modified C-Mesh
6. On the Circular Arc dialog, use the Line Label text field to name this “circle,” then click 
Create. Close the dialog.

7.4.6. Creating the Unstructured Mesh

We are now ready to create the unstructured mesh. To create this mesh, perform the following 
steps:

1. Select Create Unstructured from the Mesh menu. Unstructured mesh boundaries must be 
entered as closed-loops. For this example there will be a total of four closed-loop bound-
aries. This means there will be four entries in the Closed Loop Boundary list.

2. On the Unstructured dialog, click New Boundary. This will enter (Incomplete) into the 
Closed Loop Boundary list. Now click Add From List. In the list presented, highlight sa, sb, 
sc, and sd, the outer boundaries on the slat, then click OK. In the Closed-Loop Boundaries 
list, (Incomplete) will have changed to (Int-Boundary) followed by the four zone numbers 
of the boundary.

3. Click New Boundary, and repeat the process, adding wa, wb, wc, and wd, the outer bound-
aries on the wing, to your new boundary. Repeat the process once more for the outer bound-
aries on the flap: fa, fb, fc, and fd.

4. Click New Boundary, and this time, use Add From List to add circle. Click Reverse Direc-
tion. Notice that (Int-Boundary) changes to (Ext-Boundary). 

5. Accept all other defaults, and add the appropriate mesh label. Click Create. The Working 
dialog will appear while the mesh is generated.

The resulting mesh is shown in Figure 7-9. 

Compare this mesh to the one created in the proceeding Section 9.3, “Three Element Airfoil 
Example with a Hybrid Mesh.” You should notice that there are significantly fewer small trian-
gular cells downstream of the mixing regions. Like the last example, this unstructured mesh 
can be edited to meet the internal optimization criteria. This is achieved by setting the 
Maximum # Cells equal to 40000.
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Figure 7-9. A close-up of the Hybrid mesh.
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